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KATA PENGANTAR 

Guru yang kompeten dalam proses pembelajaran sangat penting 

sebagai kunci keberhasilan belajar peserta didik. Seorang guru yang 

kompeten dapat membangun proses pembelajaran yang baik 

sehingga dapat menghasilkan pendidikan yang berkualitas sehingga 

dapat dikatakan sebagai guru profesional. Keberhasilan guru dalam 

proses pembelajaran juga tidak terlepas adanya bahan ajar sebagai 

pegangan guru dalam menyampaikan materi pembelajaran kepada 

peserta didik. Selain sebagai pegangan guru, bahan ajar ini juga 

sebagai pegangan peserta didik dalam belajar sehingga terciptalah 

sinkronisasi materi pembelajaran antara guru dan peserta didik. Hal 

tersebut menjadikan guru sebagai komponen fasilitator dalam kegiatan 

belajar mengajar di sekolah. 

Dalam upaya untuk meningkatkan kualitas keberhasilan belajar 

peserta didik pada Mata Pelajaran Komputer Akuntansi, maka SMK 

Negeri 1 Geger Kabupaten Madiun khususnya Kompetensi Keahlian 

Akuntansi  Keuangan  dan Lembaga bekerja sama dengan Perguruan 

Tinggi Universitas PGRI Madiun menyusun sebuah Bahan Ajar 

Komputer Akuntansi Perusahaan Jasa Kelas XI untuk jenjang SMK. 

Tujuannya untuk menyiapkan bahan ajar sesuai dengan kurikulum 

yang berlaku saat ini yang bisa sebagai pegangan guru dan peserta 

didik sehingga dapat meningkatkan kompetensi guru dan peserta didik 

diera digitilisasi dalam menyusun laporan keuangan Perusahaan Jasa. 

Besar harapan saya, mudah–mudahan modul ini dapat 

membantu memperlancar dalam proses kegiatan belajar mengajar 
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disekolah khususnya Jenjang SMK sehingga kualitas keberhasilan 

belajar peserta didik dapat meningkat dan gurunya semakin kompeten. 

Madiun, 20 November 2021 

Suhadi, S.Pd. 

Guru Akuntansi SMKN 1 Geger Madiun 
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PRAKATA 

Alhamdulillah. Berkat kasih sayang Engkau-lah karya kami ini 

selesai. Berkat Engkau pula kami diberikan perlindungan dalam 

melaksanakan asistensi mengajar di SMKN 1 Geger. Sesungguhnya 

dari Engkau ilmu itu berasal dan kepada-Mu ilmu itu kembali, wahai 

Tuhanku Yang Maha Pengasih dan Maha Penyayang. 

Buku ini bertujuan memberikan gambaran secara umum 

tentang fitur aplikasi akuntansi MYOB Versi 18 ED, cara memasukkan 

transaksi berkaitan bisnis jasa, sampai pada pencetakkan laporan 

keuangan. Buku ini berisi tentang penerapan aplikasi akuntansi MYOB 

untuk perusahaan jasa di Kelas XI SMK, namun tidak menutup 

kemungkinan untuk dipelajari para pelaku UMKM di bidang berkaitan. 

Harapan kami pula, buku ini dapat digunakan mahasiswa pendidikan 

akuntansi untuk program asistensi mengajar maupun pelengkap 

perkuliahan untuk mata kuliah komputer akuntansi. Guru dan dosen 

akuntansi dan pendidikan akuntansi juga dapat memanfaatkan buku 

ini untuk mengajar. Buku ini menggunakan bahasa dan pembahasan 

sederhana yang berasal dari pengalaman sehari-hari tim penulis 

dalam mengajar. 

Terima kasih untuk pihak-pihak yang telah membantu 

terlaksananya asistensi mengajar (magang mahasiswa di sekolah) 

sampai disusunnya luaran berupa buku ini. Pertama, 

Kemendikbudristek melalui program MBKM KSKI 2021 yang memberi 

kesempatan program studi Pendidikan Akuntansi UNIPMA mencari 

mitra dan menghasilkan luaran yang lebih bermanfaat dari sekedar 

laporan. Kedua, rekan sejawat dosen Pendidikan Akuntansi UNIPMA 
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yang bekerjasama dalam tim untuk mendukung terlaksananya semua 

program, khususnya asistensi mengajar (magang mahasiswa di 

sekolah). Ketiga, SMKN 1 Geger Kabupaten Madiun atas kerjasama 

yang baik untuk pelaksanaan program dan uji kelayakan luaran buku. 

Keempat, Bapak Suhadi, S.Pd. untuk bimbingan kepada mahasiswa 

yang melaksanakan asistensi mengajar serta masukan untuk buku ini. 

Kelima, Ibu Elly Astuti, S.Pd., M.Si., CPA, CAP, yang bersedia 

mengarahkan tim penulis agar menghasilkan luaran maksimal. 

Keenam, tim validator yang telah memberi masukan berarti untuk 

penyempurnaan naskah. Semoga Tuhan membalas kebaikan Bapak/ 

Ibu dengan rezeki berlipat ganda. 

Penyusun menyadari bahwa pembuatan buku ini tidak akan 

lepas dari kekurangan. Pembaca dapat memberikan kritik dan saran 

yang bersifat membangun untuk penyempurnaan karya selanjutnya.  

Madiun, 21 November 2021 

Tim Penyusun 
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BAB I 

Pengantar MYOB 
 

 

Setelah mempelajari materi pada bab ini, siswa diharapkan: 

1. Mampu mendeskripsikan konsep komputerisasi akuntasi dan 

spesifikasi sistem komputer yang diperlukan untuk mengistal 

program aplikasi komputer akuntansi MYOB V18 ED.  

2. Mampu menginstal program aplikasi komputer akuntansi MYOB 

V18 ED pada sistem komputer yang telah disiapkan. 

3.  Mampu membuka dan menutup aplikasi komputer akuntansi MYOB 

V18 ED.  

4. Mampu mendeskripsikan fitur-fitur dalam aplikasi komputer 

akuntansi MYOB V18 ED. 

 

A. Gambaran Umum MYOB 

MYOB atau Mind Your Own Business merupakan program komputer 

untuk mengolah data akuntansi yang dibuat secara terpadu 

(integrated software). Aplikasi MYOB Accounting dibuat oleh MYOB 

Limited Australia dan mulai berkembang pada tahun 1991. Aplikasi 

MYOB ini sudah berkembang secara luas di beberapa negara. 

Adapun kegunaan dari aplikasi MYOB dalam kegiatan administrasi 

perusahaan adalah sebagai berikut: 

1. Membantu dalam menyelesaikan pekerjaan di bidang akuntansi. 

2. Menghemat waktu dalam mengerjakan pembukuan atau laporan 

keuangan. 
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3. Membantu dalam mengelola transaksi penjualan dan pembelian, 

hutang, piutang, pajak dan pengelolaan kas yang efektif dan 

efisien.  

4. Dapat memperlancar penyusunan laporan keuangan. 

Aplikasi MYOB dapat membantu kegiatan administrasi 

perusahaan. Aplikasi ini juga sering digunakan sebagai dasar 

pembelajaran komputer akuntansi mulai dari jenjang SMK sampai 

perguruan tinggi. Aplikasi MYOB Accounting juga banyak digunakan 

pada usaha bisnis skala kecil menengah ke bawah. Perusahaan 

berskala besar tidak menggunakan MYOB karena membutuhkan 

aplikasi yang lebih lengkap lagi. Perusahaan besar membutuhkan 

perancangan tersendiri sesuai dengan kompleksitas transaksi yang 

terjadi pada perusahaan tersebut. 

Aplikasi MYOB Accounting memiliki beberapa keunggulan 

dibandingkan dengan software yang sejenis, yaitu: 

1. Mudah digunakan dan mudah dimengerti oleh orang yang tidak 

mempunyai pengetahuan yang mendalam tentang komputer dan 

akuntansi karena aplikasi MYOB sangat mudah dioperasikan dan 

dapat diterapkan pada berbagai jenis usaha. 

2. Laporan keuangan dibuat secara otomatis yang pastinya lengkap 

dan akurat. 

3. Keamanan sistem cukup memadai karena tersedia password 

dengan berbagai level. 

4. Dapat diterapkan pada 105 jenis perusahaan. 

5. Dapat digunakan sesuai dengan situasi dan kondisi tiap negara. 

Jika di Indonesia, mengatur kode pajak dan penggunaan SAK-

IFRS dapat dilakukan dalam aplikasi MYOB Accounting. 
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B. Menginstall Aplikasi MYOB 

Peralatan komputer yang dibutuhkan untuk pengoperasian 

program MYOB minimal mempunyai spesifikasi sebagai berikut: 

1. 200MHz Intel Pentium Processor with at least 64 MB RAM. 

2. 200 MB of Hardisk space. 16 bit colour, 1024 x 768 screen 

resolution. Microsoft Windows versi 2000, XP, Vista atau yang 

terbaru. 

3. Windows compatible printer, mouse or pointing device. 

Jenis software MYOB yang akan digunakan dalam modul ini 

yaitu Accounting Plus 18 versi Edukasi. Berikut langkah-langkah 

untuk menginstal aplikasi MYOB V18 ED. 

1. Double klik pada setup.exe 

 
Gambar 1.1 Menu setup.exe 

 

2. Akan muncul tampilan preparing to install 
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Gambar 1.2 Persiapan menginstal 

 

3. Klik next pada tampilan Welcome to MYOB Accounting plus 

v18 ED install 

 
Gambar 1.3 Proses instalasi 

 

4. Pilih I accept the term of the license agreement, kemudian klik 

next 
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Gambar 1.4 Persetujuan lisensi 

 

5. Pilih complete, lalu klik next. Proses instalasi akan berjalan 

secara otomatis. 

 
Gambar 1.5 Tipe penginstalan 
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6. Klik next pada tampilan select program folder 

 

Gambar 1.6 Opsi folder penyimpanan 

 

7. Klik next pada tampilan Start Copying File seperti pada 

gambar 1.7. 

 
Gambar 1.7 Proses penggandaan file 
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8. Tunggu sampai proses instalasi selesai, usahakan tetap 

berada pada jendela seperti gambar 1.8. 

 
Gambar 1.8 Proses penyelesaian instalasi 

 

9. Terakhir klik finish untuk menyelesaikan proses instalasi 

 
Gambar 1.9 Konfirmasi penyelesaian instalasi 
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C. Membuka Aplikasi MYOB 

Cara membuka file data perusahaan yang sudah pernah dibuat 

sebelumnya, dapat dilakukan langkah-langkah sebagai berikut. 

1. Buka aplikasi MYOB Accounting V18 ED ➔ Klik Open 

 
Gambar 1.10 Membuka file data di aplikasi MYOB Accounting 

 

2. Pilih file yang ingin dibuka ➔ klik Open 

 
Gambar 1.11  Memilih file MYOB yang diinginkan 
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3. Konfirmasi User dan Password 

 
Gambar 1.12 Pengisian user ID dan password 

 

Dikarenakan kita menggunakan aplikasi MYOB versi Trial, 

maka pada bagian ini diabaikan saja dengan langsung klik tombol 

OK. 

 

4. Verifikasi Data 

 

 

 

 

 

 

 

 

 

 

 

Gambar 1.13 Perintah verifikasi data 
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Jika kita tidak menginginkan verifikasi data perusahaan, maka 

beri tanda centang pada kolom yang tersedia lalu Klik No. Setelah 

itu, setiap kita membuka perusahaan aplikasi MYOB tidak akan 

melakukan verifikasi data. 

5. Kemudian, kita akan masuk ke dalam menu utama MYOB 

Accounting dan aplikasi siap untuk digunakan.  

 

D. Fitur-Fitur Dalam Aplikasi MYOB 

 
Gambar 1.14 Menu utama aplikasi MYOB Accounting 

 

Dalam aplikasi MYOB Accounting, terdapat delapan fitur pada menu 

utama MYOB, yaitu: 

1. Accounts, fitur ini merupakan komponen utama aktivitas sistem 

akuntansi perusahaan yang berfungsi untuk mencatat data awal 

perusahaan yang berupa pencatatan rekening maupun 

pencatatan jurnal transaksi. 
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2. Banking, fitur ini berfungsi untuk mencatat transaksi penerimaan 

kas, pengeluaran kas, dan merekonsiliasi rekening koran dengan 

akun-akun bank pada buku besar. 

3. Sales, fitur ini digunakan untuk mencatat transaksi penjualan 

baik tunai maupun kredit, retur penjualan, dan pembayaran 

piutang dari pelanggan (customer). 

4. Time Billing, fitur ini digunakan untuk membuat arsip aktivitas 

dan faktur untuk jasa yang telah ditentukan waktunya. 

5. Purchase, fitur ini digunakan untuk mencatat transaksi 

pembelian baik tunai maupun kredit, retur pembelian, dan 

pembayaran utang kepada pemasok (supplier). 

6. Payroll, fitur ini berhubungan dengan gaji dan upah untuk 

karyawan. 

7. Inventory, fitur ini digunakan untuk mencatat aktivitas yang 

berhubungan dengan persedian dan pemeliharaan item 

persediaannya. 

8. Card File, fitur ini digunakan untuk membuat data customer, 

supplier, employee, dan personal, membuat hingga 

mengelompokkan catatan individu dan perusahaan. 

 

E. Menutup Aplikasi MYOB 

Langkah-langkah untuk menutup aplikasi MYOB adalah sebagai 

berikut: 

1. Klik File di bagian pojok atas ➔ klik Exit. 
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Gambar 1.15 Menutup aplikasi MYOB 

 

2. Selanjutnya, akan muncul perintah untuk melakukan Backup 

Data. Pada gambar 1.16., jika kita menginginkan untuk 

melakukan backup data perusahaan, klik Yes. Jika kita tidak 

menginginkan untuk melakukan backup data perusahaan, klik 

No. 

 
Gambar 1.16 Perintah backup data 
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BAB II 

Set Up File Data Baru Perusahaan 
 

 

Setelah mempelajari materi pada bab ini, siswa diharapkan: 

1. Mampu membuat file data bisnis baru untuk komputerisasi 

akuntansi perusahaan jasa. 

2. Mampu melakukan entri  data awal perusahaan jasa dengan aplikasi 

komputerisasi akuntansi MYOB V18 ED. 

 

A. Input Identitas Perusahaan  

Nama Perusahaan : Citra Laundry 

Alamat   : Jalan Antasari, No. 102 Madiun 

No telepon  : 0365-214359 

No fax   : 0365-214359 

Email   : Citralaundry@gmail.com 

Citra Laundry adalah sebuah perusahaan yang menyediakan jasa 

laundry kiloan. Laundry ini didirikan oleh Ibu Citra pada tanggal 01 

Januari 2015. Pada awalnya karena ini merupakan usaha rumahan 

Ibu Citra melakukan pencatatan transaksi secara manual dan 

dilakukan sendiri. Setelah usahanya berkembang cukup besar Ibu 

Citra mengalami kesulitan untuk melakukan pencatatan secara 

manual. Atas rekomendasi rekan sesama pengusaha, Ibu Citra 

akhirnya memutuskan untuk menggunakan sistem pencatatan 

komputerisasi dengan menggunakan program MYOB Accounting 

Plus v18 ED. 

mailto:Citralaundry@gmail.com
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Hal pertama yang harus dilakukan untuk memulai bekerja 

dengan aplikasi MYOB adalah dengan menginput informasi umum 

perusahaan, langkahnya sebagai berikut: 

1. Buka aplikasi MYOB kemudian klik create 

 
Gambar 2.1 Tampilan awal membuka MYOB 

 

2. Setelah di klik create akan muncul tampilan seperti pada gambar 

2.2. Ada beberapa hal yang harus diisi sebelum memulai aplikasi 

MYOB seperti, tahun akuntansi, dan memilih daftar akun yang 

digunakan. 

 
Gambar 2.2 Penjelasan tentang memulai aplikasi MYOB 
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3. Setelah klik next pada tampilan di atas maka akan muncul 

tampilan seperti di bawah ini: 

 
Gambar 2.3 Tampilan informasi perusahaan 

 

Pada tampilan ini muncul beberapa pertanyaan seputar 

informasi perusahaan yang harus diisi: 

a. Enter your 12 digit MYOB product Serial Number 

Kotak serial number ini untuk MYOB versi latihan (trial) bisa 

dikosongkan. Kotak serial number bisa diisi jika 

menggunakan MYOB versi legal. 

b. Enter Information about your company 

Ada informasi berupa Company Name (nama perusahaan), 

ABN (nomor NPWP perusahaan), Address (alamat 

perusahaan), Phone Number (nomor telepon) , Fax Number 

(nomor faximile) serta Email Address (alamat email). 
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Beberapa informasi tersebut bisa diisi sesuai dengan 

informasi perusahaan yang ada. Khusus untuk Company 

Name terdapat tanda (*) maka harus diisi. Data yang ada diisi 

sesuai dengan informasi perusahaan kemudian bisa klik next. 

 

B. Input Informasi Periode Akuntansi 

Kebijakan umum yang diterapkan perusahaan sebagai berikut. 

1. Umum 

a. Sistem pembukuan perusahaan dengan dasar basis akrual. 

b. Periode Akuntansi Tahunan, dimulai dari 1 Januari s/d 31 

Desember 2017. 

c. Pada setiap akhir bulan disusun neraca saldo. 

d. Pada setiap akhir tahun disusun laporan keuangan. 

e. Digunakan jurnal umum dan khusus untuk mencatat setiap 

transaksi. 

f. Mata uang yang digunakan adalah Rupiah. 

2. Pembelian 

a. Setiap pembelian akan diperhitungkan PPN Masukan 10% 

dari nilai pembelian. 

b. Setiap retur pembelian akan diperhitungkan pengurangan 

atas nilai hutang dan PPN Masukan. 

c. Termin pembayaran 2/10, Net 30. Pelunasan piutang dalam 

periode diskon akan mengurangi nilai hutang dan PPN 

Masukan. 

d. Keterlambatan pelunasan hutang di denda 1 % dari nilai 

hutang (pembelian). 

3. Penjualan  
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a. Setiap penjualan jasa akan diperhitungkan PPN Keluaran 

10% dari nilai penjualan. 

b. Setiap retur penjualan akan diperhitungkan pengurangan 

atas nilai piutang dari nilai PPN Keluaran. 

c. Termin pembayaran 2/ 10, Net 30. Pelunasan piutang dalam 

periode diskon akan mengurangi nilai piutang dan nilai PPN 

Keluaran. 

d. Keterlambatan Pembayaran piutang akan di denda  1 % dari 

nilai  piutang (penjualan). 

4. Pengeluaran Kas 

a. Pengeluaran kas diatas Rp 1.000.000-, dilakukan dengan Cek. 

b. Setiap pengeluaran Cek harus didukung dengan Bukti 

Pengeluaran Kas. 

c. Setiap pengeluaran kas sebesar Rp 1.000.000-, atau kurang 

dilakukan dengan menggunakan dana Kas Kecil. 

5. Penerimaan Kas: seluruh penerimaan kas disetor ke bank. 

Langkah kedua yaitu menginput beberapa informasi periode 

akuntansi yang berjalan pada perusahaan: 

1. Current Financial Year: diisi tahun buku untuk transaksi yang 

akan diinput. 

2. Last Month of Financial Year: diisi bulan terakhir pada satu 

tahun buku akuntansi 

3. Coversion Month: diisi bulan sebelum memulai transaksi. Jadi 

misalnya transaksi yang akan dikejakan Bulan Desember, maka 

conversion month diisi bulan November.  

4. Number of Accounting Periods: Jika periode akuntansi yang 

dibuat adalah untuk 1 tahun maka dipilih Twelve. Namun jika 
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periode akuntansi yang dibuat adalah periode triwulan maka 

dipilih Thirteen.  

 
Gambar 2.4 Tampilan Informasi Akuntansi 

 

5. Setelah data-data diisi sesuai dengan informasi akuntansi 

perusahaan, maka bisa klik next.  

 
Gambar 2.5 Konfirmasi Informasi Akuntansi Perusahaan 
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6. Pada tampilan konfirmasi informasi akuntansi perusahaan ini,  

klik back jika ada informasi yang salah input dan klik next jika 

informasi yang di-input sudah sesuai.  

 

C. Mengatur Daftar Akun 

Berdasarkan informasi perusahaan yang telah diinput, maka 

selanjutnya muncul kotak dialog untuk membuat daftar akun. Pada 

aplikasi MYOB telah disediakan 3 pilihan yaitu: 

 
Gambar 2.6 Tampilan Pengaturan Daftar Akun 

 

1. I Would Like To Start With One Of The List Provided By MYOB 

Accounting  

Jika kita memilih pilihan ini, kita hanya menentukan klasifikasi 

industri dan jenis bisnis perusahaan, sedangkan daftar akunnya 

telah disediakan oleh MYOB. Setelah klik opsi 1, maka kita akan 
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diarahkan untuk menentukan klasifikasi jenis perusahaan dan 

tipe bisnis seperti pada tampilan gambar 2.7. 

 

Gambar 2.7 Membuat daftar akun perusahaan menggunakan opsi 1 

 

a. Industry Classification 

Ada beberapa klasifikasi industri yang telah disediakan 

MYOB. Klasifikasi tersebut sektor primer (agriculture), 

perusahaan jasa (service), perusahaan dagang (retail), 

perusahaan manufaktur (manufacturing), bidang usaha lain 

(other) dan semua jenis usaha (all). Jika kesulitan untuk 

menentukan klasifikasi usaha perusahaan yang sedang 

dikerjakan, maka sebaiknya dipilih all. 

b. Type of Business 

Tipe bisnis yang telah disediakan MYOB sangat beragam. Cara 

melanjutkan pembuatan data perusahaan cukup memilih 

salah satu tipe bisnis yang sesuai. 
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c. Account List 

Daftar akun pada pilihan ini telah disediakan MYOB dan tidak 

bisa diedit secara langsung. Hal ini kelemahan jika memilih 

opsi yang pertama pada pengaturan daftar akun. 

2. I Would Like To Import Of Acounts  Provided By My 

Accountant After 1’m Done Creating My Company File 

Pilihan ini digunakan jika kita akan membuat perusahaan baru 

dengan mengimpor daftar akun dari aplikasi Microsoft Excel. 

Sebelum memasukkan data data di MYOB, kita harus sudah 

membuat daftar akun pada microsoft excel. 

3. I Would Like To Build My Own Accounts List Once I Begin 

Using MYOB Accounting 

Opsi  ini dapat dipilih  jika kita akan membuat daftar akun sendiri 

dengan menyesuaikan beberapa link account pada MYOB.  

Setelah mengetahui penjelasan mengenai 3 pilihan di atas, 

selanjutnya kita coba pilih pilihan yang ketiga. 

 

D. Mengatur Lokasi Penyimpanan File 

Langkah setelah memilih opsi yang ketiga untuk membuat daftar 

akun, maka akan muncul kotak dialog. Kotak tersebut untuk 

mengatur lokasi penyimpanan file seperti gambar 2.8. Tentukan 

lokasi penyimpanan file supaya data mudah dibuka kembali dengan 

cara klik change. Jika lokasi penyimpanan tidak dirubah maka data 

otomatis tersimpan di Local Disk C ➔ Program Files MYOB 18 ED. 

Setelah itu klik next. 
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Gambar 2.8 Lokasi penyimpanan file MYOB 

 

E. Kesimpulan   

Setelah semua langkah-langkah di atas dilakukan maka akan muncul 

tampilan seperti berikut: 

 
Gambar 2.9 Tampilan Command Centre 
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1. Setup Assistant 

Klik Setup Assistant jika akan melanjutkan untuk menyesuaikan 

file akuntansi perusahaan. Pada opsi ini kita akan dipandu setiap 

langkah yang harus dilakukan untuk menggunakan MYOB. 

2. Command Centre 

Klik Command Centre jika ingin melanjutkan untuk memulai 

memasukkan transaksi. Jika mengklik command centre ini, maka 

akan diarahkan ke menu utama MYOB. 
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BAB III 

Menyiapkan dan Mengelola 

Akun Perusahaan 
 

 

Setelah mempelajari materi pada bab ini, siswa diharapkan: 

1. Mampu memahami pengelompokan akun 

2. Mampu menyusun daftar akun dan nomor akun pada perusahaan 

jasa. 

3. Mampu mengentry saldo awal akun buku besar perusahaan jasa.  

4. Mampu mengatur linked account. 

5. Mampu membuat kode pajak. 

 

 

Pada saat berhasil melakukan set up awal data perusahaan, kita akan 

diarahkan ke command centre atau bisa disebut juga menu awal pada 

MYOB V18 ED. Disini terdapat beberapa fitur seperti yang sudah 

dijelaskan pada BAB I.  Sebelum kita membuat/memasukkan daftar 

akun perusahaan, kita sudah harus memahami tentang 

pengelompokkan klasifikasi akun-akunnya. Dalam MYOB terdapat 8 

kelompok klasifikasi akun header, yaitu : 

1. Aset (Asset) ➔ Kode Akun: 1 

Klasifikasi sub tipe akun Aset yaitu Bank, Account Receivable 

(Piutang Usaha), Other Current Asset (Aset Lancar Lainnya), Fixed 

Asset (Aset Tetap), dan Other Asset (Aset Lainnya).  

2. Liabilitas/Utang (Liability) ➔ Kode Akun: 2 
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Klasifikasi sub tipe akun Liabilitas yaitu Credit Card (Kartu Kredit), 

Account Payable (Utang Usaha), Other Current Liability (Utan Lancar 

Lainnya), Long Term Liability (Utang Jangka Panjang), dan Other 

Liability (Utang Lainnya).  

3. Ekuitas/Modal (Equity) ➔ Kode Akun: 3 

4. Pendapatan (Income) ➔ Kode Akun: 4 

5. Harga Pokok Penjualan (Cost of Sales) ➔ Kode Akun: 5 

6. Beban (Expense) ➔ Kode Akun: 6 

7. Pendapatan Lain-Lain (Other Income) ➔ Kode Akun: 8 

8. Beban Lain-Lain (Other Expense) ➔ Kode Akun: 9 

Ketika sudah memahami kelompok klasifikasi akunnya, kita bisa 

mulai memasukkan daftar akun perusahaannya. 

 

A. Membuat Daftar Akun 

Berikut merupakan daftar akun yang dimiliki oleh perusahaan. 

NO. 

AKUN 

NAMA ASET KETERA

NGAN 
TIPE AKUN 

1-0000 ASET Header Aset 

1-1000 Aset Lancar Header Aset 

1-1100 Bank Mandiri Detail Bank 

1-1200 Kas Kecil Detail Bank 

1-1300 Piutang Usaha Detail Piutang Usaha 

1-1400 PPN Masukan Detail Aset Lancar Lainnya 

1-1500 Perlengkapan Detail Aset Lancar Lainnya 

1-1600 Asuransi Dibayar Dimuka Detail Aset Lancar Lainnya 

1-1700 Sewa Dibayar Dimuka Detail Aset Lancar Lainnya 

1-2000 Aset Tetap Header Aset 

1-2100 Peralatan Detail Aset Tetap 

1-2110 Akum. Dep. Peralatan Detail Aset Tetap 

2-0000 LIABILITAS Header Liabilitas 

2-1000 Liablitas Jangka Pendek Header Liabilitas 

2-1100 Utang Usaha Detail Utang Usaha 

2-1200 PPN Keluaran Detail Liabilitas Jangka Pendek 
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NO. 

AKUN 

NAMA ASET KETERA

NGAN 
TIPE AKUN 

Lainnya 

2-1300 Utang Gaji & Upah Detail Liabilitas Jangka Pendek 

Lainnya 

2-1400 Utang Beban Detail Liabilitas Jangka Pendek 

Lainnya 

2-2000 Liabilitas Jangka 

Panjang 

Header Liabilitas 

2-2100 Bank Mandiri Loans Detail Liabilitas Jangka 

Panjang 

3-0000 EKUITAS Header Ekuitas 

3-1000 Modal, Citra Detail Ekuitas 

3-2000 Prive, Citra Detail Ekuitas 

4-0000 PENDAPATAN Header Pendapatan 

4-1000 Pendapatan Laundry Detail Pendapatan 

4-2000 Retur Penjualan Detail Pendapatan 

4-3000 Diskon Penjualan Detail Pendapatan 

5-0000 HARGA POKOK 

PENJUALAN 

Header Harga Pokok 

Penjualan 

5-1000 Diskon Pembelian Detail Harga Pokok Penjualan 

6-0000 BEBAN OPERASIONAL Header Beban 

6-1000 Beban Gaji & Upah Detail Beban 

6-1100 Beban Perlengkapan Detail Beban 

6-1200 Beban Iklan Detail Beban 

6-1300 Beban Asuransi Detail Beban 

6-1400 Beban Pemeliharaan Detail Beban 

6-1500 Beban Sewa Detail Beban 

6-1600 Beban Depresiasi Detail Beban 

8-0000 PENDAPATAN LAIN-

LAIN 

Header Pendapatan Lain-Lain 

8-1000 Pendapatan Bunga Detail Pendapatan Lain-Lain 

8-2000 Biaya Keterlambatan 

Pelunasan Piutang 

Detail Pendapatan Lain-Lain 

9-0000 BEBAN LAIN-LAIN Header Beban Lain-Lain 

9-1000 Beban Bunga Detail Beban Lain-Lain 

9-2000 Beban Administrasi Bank Detail Beban Lain-Lain 

9-3000 Biaya Keterlambatan 

Pembayaran Utang 

Detail Beban Lain-Lain 
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Langkah membuat/memasukkan daftar akun perusahaan atau 

mengetahui akun-akun yang sudah disediakan oleh MYOB, adalah: 

1. Klik fitur Accounts ➔ Accounts List. 

 
Gambar 3.1 Tampilan menu awal MYOB V18 ED 

 

2. Setelah itu kita akan melihat tampilan dalam Accounts List 

(Daftar Akun), lihat Gambar 3.2. 

Di bagian atas (Gambar 3.2.), terdapat klasifikasi akun dan di 

bagian bawah terdapat 5 informasi yang perlu dipahami: 

a. Account Name: informasi ini berisikan nama akun beserta 

nomor akunnya. 

b. Type: informasi ini berisi tentang tipe akun, seperti Aset, 

Bank, Akun Piutang, Aset Lancar Lainnya, Aset Tetap, Akun 

Utang, Liabilitas Jangka Pendek, Liabilitas Jangka Panjang, 

Ekuitas, Pendapatan, Harga Pokok Penjualan, Beban, 

Pedapatan Lainnya, dan Beban Lainnya. 
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c. Tax: informasi ini berisi tentang kode pajak. Untuk akun 

header (akun yang di tebalkan) pajaknya dikosongkan, 

sedangkan untuk akun detail berisi N-T atau tidak kena Pajak 

(Non Tax). 

 
Gambar 3.2 Tampilan daftar akun 

 

d. Linked: berisi akun-akun yang telah dipetakan/di-linked yang 

berhubungan dengan akun lainnya. Akun yang ada tanda 

centang (√), berarti akun tersebut telah dipetakan dan 
berhubungan dengan akun lainnya. 

e. Balance: berisi saldo awal dari masing-masing akun. Saldo 

awal ini didapat dari saldo akhir bulan sebelum transaksi 

yang akan dikerjakan. Adapun saldo akun detail, bisa dilihat 

pada daftar saldo awal yang terdapat pada soal yang akan 

dikerjakan. Sedangkan untuk saldo akun header adalah 
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jumlah akumulasi dari saldo akun detail sesuai dengan 

klasifikasinya masing-masing. 

Pada bagian ini kita akan pecah menjadi 3 hal, yaitu: 

memasukkan akun baru, mengubah akun, dan menghapus akun. 

a. Memasukkan Akun Baru 

Setelah kita masuk ke dalam tampilan daftar akun (accounts 

list), langkah selanjutnya adalah : 

1) Klik New. 

 
Gambar 3.3 Memasukkan akun baru 

 

2) Setelah klik new, kita akan dihadapkan pada tampilan 

seperti pada Gambar 3.4. 
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Gambar 3.4 Mengisi informasi akun baru 

 

Pada tampilan ini, kita diminta untuk mengisi informasi 

akun yang akan dibuat. 

a. Header account: digunakan untuk akun judul atau 

kelompok klasifikasi akunnya. Sedangkan detail 

account: digunakan untuk akun-akun yang akan 

digunakan dalam proses pencatatan transaksi. 

b. Account Classification: diisi dengan akun yang sesuai 

dengan kelompok klasifikasinya, seperti aset, liabilitas, 

ekuitas, dsb. 

c. Account Type: informasi ini diisi sesuai dengan tipe 

akunnya, seperti aset lancar, aset tetap, piutang, utang, 

liabilitas jangka pendek, liabilitas jangka panjang, 

ekuitas, dsb. 



32 

 

d. Account Number: diisi dengan nomor akunnya, bisa 

dilihat di daftar akun pada soal yang akan dikerjakan. 

Kita hanya tinggal mengisi 4 digit nomor akun 

belakangnya saja. 

e. Account Name: diisi dengan nama akunnya.  

f. Opening Balance: informasi ini berisi saldo awal akun 

tersebut. Tetapi ketika memasukkan daftar akun baru, 

opening balance ini tidak perlu diisi disini karena akan 

diisi pada tempat yang berbeda yang akan dijelaskan 

pada sub materi berikutnya. 

 
Gambar 3.5 Daftar akun baru 

 

3. Setelah mengisi semua informasi yang diminta, kita bisa langsung 

klik OK. 
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b. Mengubah Akun 

Langkah mengubah akun yang sesuai dengan PSAK dari akun 

yang telah disediakan oleh MYOB dalam bahasa Inggris, 

sebagai berikut: 

1) Buka/aktifkan akun yang akan diubah dengan salah satu 

cara sebagai berikut: 

a) klik tanda panah di tepi kiri (    ) nama akun 

b) double klik pada nama akun 

c) klik pada nama akun lalu klik edit di bagian bawah. 

 
Gambar 3.6 Mengubah akun 

 

2) Selanjutnya kita akan dihadapkan seperti pada tampilan 

ambar 3.7, kita hanya tinggal mengubah informasi apa saja 

yang akan kita ubah sesuai dengan daftar akun 

perusahaan. 
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Gambar 3.7 Informasi akun yang akan diubah 

 

3) Setelah diubah, langkah terakhirnya adalah klik OK. 

 

c. Menghapus Akun 

Apabila ada akun yang tidak digunakan dalam proses 

pencatatan transaksi, maka kita bisa hapus akun tersebut 

dengan langkah-langkah sebagai berikut. 

a. Menghapus akun yang berlinked 

Akun yang berlinked tidak bisa dihapus karena akun 

tersebut telah berkaitan dengan akun-akun yang lain. Oleh 

karena itu, akun-akun yang berlinked hanya bisa diedit 

pada bagian nama maupun nomor akun dengan akun yang 

lain.  
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b. Menghapus akun tanpa Linked 

a) Buka/aktifkan akun yang akan dihapus dengan cara 

klik nama akun tersebut. 

b) Setelah itu kita klik Edit dibagian atas ➔Delete 

Account 

 
Gambar 3.8 Menghapus akun 

 

Cara di atas digunakan jika kita akan menghapus satu 

akun atau beberapa akun saja. Cara menghapus akun yang 

jumlahnya relatif banyak, bisa menggunakan cara di bawah 

ini: 

a) Klik setup bagian atas kemudian akan muncul beberapa 

pilihan seperti gambar 3.9. Pilih pada menu Easy Setup 

Assistant 
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Gambar 3.9 Menu pada setup 

 

b) Pilih Accounts pada menu Easy Setup Assistant 

 
Gambar 3.10 Menu pada easy setup assistant 
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c) Klik Next 

 
Gambar 3.11 Tampilan pada accounts easy setup assistant 

 

d) Pilih Accounts yang akan dihapus 

 
Gambar 3.12 Daftar akun pada easy setup assistant 

 

e) Klik Delete 
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B. Entry Neraca Saldo Awal 

Neraca saldo awal adalah saldo akun diawal periode akuntansi. Saldo 

awal ini didapat dari saldo akhir dari bulan sebelumnya. Sebagai 

contoh, transaksi yang akan dicatat adalah Januari 2017, maka saldo 

awal didapat dari saldo akhir bulan Desember 2016. Jika transaksi 

yang akan dicatat adalah bulan Mei 2017, maka saldo awal berasal 

dari saldo akhir bulan April 2017. 

 

“Citra Laundry” 

Neraca Saldo 

Periode 30 November 2017 

NO. 

AKUN 

NAMA AKUN DEBIT KREDIT 

1-1100 Bank Mandiri 52.800.000  

1-1200 Kas Kecil 2.200.000  

1-1300 Piutang Usaha 10.540.000  

1-1500 Perlengkapan 3.275.000  

1-1600 Asuransi Dibayar Dimuka 5.000.000  

1-1700 Sewa Dibayar Dimuka 2.400.000  

1-2100 Peralatan 67.670.000  

1-2110 Akum. Dep. Peralatan  6.767.000 

2-1100 Utang Usaha  9.762.000 

2-1300 Utang Gaji & Upah  680.000 

2-1400 Utang Beban  920.000 

2-2100 Bank Mandiri Loans  40.000.000 

3-1000 Modal, Citra  68.000.000 

3-2000 Prive, Citra 400.000  

4-1000 Pendapatan Laundry  25.628.000 

4-2000 Retur Penjualan 360.000  

4-3000 Diskon Penjualan 240.000  

6-1000 Beban Gaji & Upah 4.800.000  

6-1100 Beban Perlengkapan 438.000  

6-1200 Beban Iklan 354.000  

6-1300 Beban Asuransi 244.000  

6-1400 Beban Pemeliharaan 254.000  

6-1500 Beban Sewa 720.000  

8-1000 Pendapatan Bunga  243.000 
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NO. 

AKUN 

NAMA AKUN DEBIT KREDIT 

9-1000 Beban Bunga 175.000  

9-2000 Beban Administrasi Bank 130.000  

TOTAL 152.000.000 152.000.000 

 

Langkah-langkah untuk mengisi saldo awal adalah sebagai 

berikut : 

1. Klik Setup ➔ Balances ➔ Account Opening Balances 

 
Gambar 3.13 Membuka accounts opening balances 

 

2. Selanjutnya, isikan nominal saldo awal pada Account Opening 

Balances. Perlu diingat, bahwa tidak semua akun memiliki saldo 

awal, jadi pastikan untuk teliti saat memasukkan saldo awal pada 

akun. Jika akun tidak memiliki saldo awal, silakan dikosongkan. 

Jenis akun kontra nilai nominal akunnya harus ditambah tanda 

minus (-) di antaranya: 

a. Akumulasi penyusutan peralatan 
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b. Prive 

c. Diskon Penjualan 

d. Retur Penjualan 

 
Gambar 3.14 Mengisi account opening balances 

 

3. Cara mengecek apakah saldo yang kita masukkan sudah benar 

atau belum, perhatikan pada bagian Amount left to be allocated, 

pada bagian tersebut nominal harus sebesar Rp0,-. 

 
Gambar 3.15 Mengecek kebenaran saldo awal 

 

C. Mengatur Linked Account 

Mengatur Linked Account digunakan untuk melakukan pemetaan 

pada akun yang telah dibuat MYOB. Linked Account akan 

berpengaruh dengan saldo akun yang berkaitan atau berhubungan 
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pada saat pencatatan suatu transaksi. Ada 4 pengaturan dalam linked 

account, yaitu Accounts & Banking Accounts, Sales Accounts, 

Purchases Account, dan Payroll Account. 

1. Accounts & Banking Account 

Pada bagian ini, kita akan mengatur linked accounts untuk 

transaksi yang berhubungan dengan penerimaan dan 

pengeluaran kas. Transaksi penerimaan dan pengeluaran kas 

pasti akan mempengaruhi akun kas, baik kas di bank, kas kecil, 

maupun kas di tangan. Pengaturan linked account ini, difokuskan 

untuk mengatur akun, baik untuk pembayaran elektronik 

maupun pembayaran yang belum disetorkan ke bank 

(Undeposited Funds). Adapun langkah-langkah yang harus 

dilakukan, yaitu: 

a. Klik Setup pada bagian atas, lalu Linked Accounts dan 

Accounts & Banking Accounts. 

 
Gambar 3.16 Membuka linked accounts 
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b. Selanjutnya, pilihlah akun kas yang akan dipetakan untuk 

transaksi pembayaran elektronik dan transaksi pembayaran 

tunai. 

 
Gambar 3.17 Mengatur accounts & banking accounts 

 

1) Equity Account for Historical Balancing: digunakan sebagai 

akun penyeimbang. Jika antara Aset dan Kewajiban 

ditambah modal tidak balance maka selisih tersebut yang 

akan masuk ke dalam Historical Balancing. 

2) Bank Account for Electrical Payments: diarahkan pada 

akun Bank yang digunakan untuk pembayaran elektronik. 

3) Bank Account for Undeposited Funds: diarahkan pada akun 

yang digunakan untuk pembayaran tunai 

c. Cara memilih akun, kita bisa klik tanda panah ke bawah  , 

lalu pilih akun yang akan dipetakan. 
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Gambar 3.18 Memilih akun yang akan dipetakan 

 

d. Setelah memilih akun klik use account, lalu klik OK. 

 

2. Sales Accounts 

Pengaturan Linked Accounts untuk bagian Sales accounts ini 

digunakan untuk memetakan akun yang berkaitan dengan 

penjualan kredit. Langkah-langkah yang harus dilakukan untuk 

melakukan linked accounts pada akun penjualan/sales accounts 

adalah:  

a. Klik Setup ➔ Linked Account ➔ Sales Accounts 

b. Pilihlah akun yang berkaitan dengan penjualan kredit. 

Adapun informasi yang perlu kita ketahui : 

1) Asset Account for Tracking Receivables: diisi dengan akun 

yang berkaitan untuk mencatat transaksi piutang 

pelanggan. 
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Bank Account for Customer Receipts: diisi dengan akun yang 

berkaitan untuk mencatat penerimaan pembayaran dari 

pelanggan. 

 
Gambar 3.19 Mengatur sales accounts 

 

2) I Charge Freight on Sales: informasi ini di centang apabila 

perusahaan memiliki kebijakan membebankan biaya 

angkut penjualan kepada  pelanggan/customer. Setelah itu, 

petakan akun yang digunakan untuk mencatat penerimaan 

pendapatan angkut perusahaan. 

3) I Track Deposits Collected From Customer: informasi ini 

dicentang apabila perusahaan memiliki kebijakan 

menerima uang muka dari pelanggan/customer. Setelah itu, 

petakan akun yang digunakan untuk mencatat penerimaan 

uang muka dari pelanggan/customer tersebut. 
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4) I Give Discounts For Early Payments: informasi ini dicentang 

apabila perusahaan memiliki kebijakan untuk memberikan 

diskon/potongan penjualan kepada pelanggan apabila 

membayar piutang lebih awal. Setelah itu, petakan akun 

yang berkaitan dengan transaksi tersebut. 

5) I Assess Charges For Late Payments: informasi ini dicentang 

apabila perusahaan memiliki kebijakan untuk memberi 

denda atas keterlambatan pembayaran piutang oleh 

pelanggan. Setelah itu, petakan akun yang berkaitan dengan 

transaksi tersebut. 

c. Langkah terakhir, klik OK. 

 

3. Purchases Accounts 

Pengaturan Linked Accounts untuk bagian Purchases Accounts ini 

digunakan untuk memetakan akun yang berkaitan dengan 

Pembelian kredit. Langkah-langkah yang harus dilakukan untuk 

melakukan linked accounts pada akun pembelian/purchases 

accounts adalah : 

a. Klik Setup ➔ Linked Account ➔ Purchases Accounts 

b. Pilihlah akun yang berkaitan dengan pembelian kredit. 

Adapun informasi yang perlu kita ketahui: 

1) Liability Account for Tracking Payables: diisi dengan akun 

yang berkaitan untuk mencatat transaksi utang kepada 

pemasok. 
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Gambar 3.20 Mengatur purchases accounts 

 

2) Bank Account for Paying Bills: diisi dengan akun yang 

berkaitan untuk membayar tagihan dari pemasok. 

3) I Can Receive Items Without A Supplier Bill: informasi ini 

dicentang apabila kebijakan perusahaan dapat menerima 

barang tanpa tagihan dari pemasok. Setelah itu, petakan 

akun yang berkaitan dengan transaksi tersebut. 

4) I Pay Freight On Purchases: informasi ini dicentang apabila 

kebijakan perusahaan membayar biaya angkut pembelian 

dari pemasok. Setelah itu, petakan akun yang berkaitan 

dengan pembayaran untuk biaya angkut pembelian. 

5) I Track Deposits Paid To Suppliers: informasi ini dicentang 

apabila kebijakan perusahaan dapat membayar uang 

muka terlebih dahulu kepada pemasok. Setelah itu, 
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petakan akun yang digunakan untuk mencatat 

pembayaran uang muka kepada pemasok/suppliers. 

6) I Take Discounts For Early Payment: informasi ini 

dicentang apabila kebijakan perusahaan untuk 

mendapatkan diskon/potongan pembelian kepada 

pemasok apabila membayar utang lebih awal. Setelah itu, 

petakan akun yang berkaitan dengan transaksi tersebut. 

7) I Pay Charges For Late Payment: informasi ini dicentang 

apabila kebijakan perusahaan untuk membayar denda 

atas keterlambatan pembayaran utang kepada pemasok. 

Setelah itu, petakan akun yang berkaitan dengan transaksi 

tersebut. 

8) Langkah terakhir, klik OK. 

 

4. Payroll Accounts 

Pengaturan Linked Accounts untuk bagian Payroll Accounts ini 

digunakan untuk memetakan akun yang berkaitan dengan 

pembayaran gaji & upah karyawan perusahaan. Langkah-langkah 

yang harus dilakukan untuk melakukan linked accounts pada 

akun payroll accounts adalah: 

a. Klik Setup ➔ Linked Accounts ➔ Payroll Accounts 

b. Pilih akun yang digunakan terkait pembayaran gaji & upah. 

Informasi yang perlu kita ketahui adalah: 

1) Bank Account For Cash Payments: diisi dengan akun yang 

digunakan untuk melakukan pembayaran gaji dan upah 

secara tunai. 
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Gambar 3.21 Mengatur payroll accounts 

 

2) Bank Account For Cheque Payments: diisi dengan akun 

yang digunakan untuk melakukan pembayaran gaji dan 

upah menggunakan cek. 

3) Bank Account For Electronic Payments: diisi dengan akun 

yang digunakan untuk melakukan pembayaran gaji dan 

upah melalui transfer dari rekening bank. 

4) Default Employee Expense Account: diisi dengan akun yang 

digunakan perusahaan untuk membayar gaji karyawan 

dengan gaji bulanan tetap. 

5) Default Wages Expense Account: diisi dengan akun yang 

digunakan perusahaan untuk membayar upah karyawan 

dihitung per satuan produk yang dihasilkan. 
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6) Default Tax/Deductions Payable Account: diisi dengan 

akun yang digunakan untuk mencatat gaji dan upah yang 

masih terutang / PPh karyawan terutang. 

c. Langkah terakhir, klik OK. 

 

D. Menyesuaikan Kode Pajak 

Salah satu pajak yang sering digunakan dalam dunia usaha adalah 

PPN atau Pajak Pertambahan Nilai. PPN adalah kewajiban pajak yang 

harus dibayar oleh konsumen dan perusahaan harus menghitung, 

memungut, melaporkan, serta menyetorkan PPN kepada kas Negara. 

PPN yang harus dibayarkan oleh perusahaan biasa disebut dengan 

PPN terutang, dimana PPN Terutang didapat dari selisih antara PPN 

Keluaran dan PPN Masukan. PPN Keluaran adalah PPN yang didapat 

dari konsumen saat perusahaan melakukan penjualan barang. PPN 

Masukan adalah jumlah PPN yang dibayar perusahaan saat 

melakukan pembelian barang. 

1. Membuat Kode Pajak 

Langkah-langkah yang harus dilakukan ketika membuat kode 

pajak baru adalah: 

a. Klik Lists ➔ Tax Codes 
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Gambar 3.22 Tax Codes 

 

b. Klik New 

 
Gambar 3.23 Daftar kode pajak 

 

c. Isikan informasi pajak yang akan dibuat yang terdiri dari: 
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1) Tax Code: diisi dengan Kode Pajak yang akan dibuat. 

2) Description: diisi dengan deskripsi pajak yang akan dibuat. 

3) Tax Type: diisi tipe pajak yang sesuai dengan pajak yang 

akan dibuat. 

4) Rate: diisi dengan persentase pajak. 

5) Linked Account for Tax Collected: diisi dengan akun yang 

digunakan untuk menerima pajak yang diambil dari 

konsumen. 

6) Linked Account for Tax Paid: diisi dengan akun yang 

digunakan untuk mencatat pajak yang sudah dibayar oleh 

perusahaan saat pembelian. 

 
Gambar 3.24 Membuat kode pajak baru 

 

d. Klik OK. 
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2. Mengubah Kode Pajak 

Langkah-langkah yang digunakan untuk mengubah kode pajak 

adalah sebagai berikut : 

a. Klik Lists ➔ Tax Codes 

b. Pilih pajak dengan kode GST (Goods & Services Tax) dan rate 

10%, lalu edit 

c. Ubah informasi hanya pada tax codes, description, linked 

account for tax collected, dan linked account for tax paid. 

Sesuaikan informasi yang diubah dengan pajak yang 

digunakan perusahaan, seperti PPN. 

 
Gambar 3.25 Mengubah informasi kode pajak 

 

d. Klik OK. 
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3. Menghapus Kode Pajak 

Langkah-langkah yang harus dilakukan saat ingin menghapus 

kode pajak adalah sebagai berikut : 

a. Klik Lists ➔ Tax Codes 

b. Pilih akun pajak yang ingin dihapus, klik kanan, lalu Delete 

Tax Code 

 
Gambar 3.26 Menghapus kode pajak 

 

Adapun cara lain yang dapat digunakan untuk menghapus kode 

pajak, sebagai berikut: 

a. Klik Lists ➔ Tax Codes 

b. Pilih akun pajak yang ingin dihapus, klik Edit pada menu di 

atas, lalu Delete Tax Code 
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Gambar 3.27 Menghapus Kode Pajak Menggunakan Menu Edit 
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BAB IV 

Mengelola Kartu Piutang dan Utang 
 

Setelah mempelajari materi pada bab ini, siswa diharapkan: 

1. Mampu membuat daftar customer untuk perusahaan jasa.  

2. Mampu membuat daftar suplier untuk perusahaan jasa.  

3. Mampu mengentry saldo awal piutang untuk perusahaan jasa. 

4. Mampu mengentry saldo awal utang untuk perusahaan jasa. 

 

Setiap perusahaan selalu memiliki saldo saldo piutang dan utang 

periode lalu yang ada kaitannya dengan periode yang akan dikerjakan. 

Untuk mengelola kartu piutang dan utang maka aplikasi MYOB 

menyediakan  menu Card File ➔ Card List 

 
Gambar 4.1 Tampilan card file untuk membuat saldo piutang dan utang 

 

Pada Card List ini tersedia empat kelompok utama yaitu Customer, 

Supplier, Employee, dan Personal. Dari keempat kelompok utama ini 
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yang akan digunakan untuk saldo piutang adalah Customer dan untuk 

saldo utang adalah Supplier. Kedua menu tersebut digunakan untuk 

entry saldo awal piutang usaha dan utang usaha. 

 

A. Membuat Data Pelanggan  

Untuk dapat entry saldo awal piutang harus membuat beberapa data 

pelanggan pada perusahaan jasa yang akan digunakan sebagai 

contoh kasus pada modul ini adalah: 

Kode Nama Customer Alamat 

C01 Panti Asuhan “Al Ikhlas” 

Jl. Margatama No. 16 

Madiun–Jawa Timur Kode Pos: 63111 

No Telp: 0361-445673 

Email: alikhlas123@gmail.com 

C02 Sanggar Tari “Elmanda” 

Jl. Anekasari No. 07 

Madiun-Jawa Timur Kode Pos: 63111 

No Tlp: 0361-449693 

Email: sanggartarielmanda@gmail.com 

C03 Klinik Sehat 

Usada 

Jl. Usadasari No. 12 

Madiun–Jawa Timur Kode Pos: 63111 

No Tlp: 0361-435873 

Email: kliniksehatusada@gmail.com 

 

Langkah-langkah untuk membuat data pelanggan adalah: 

1. Membuka Card file ➔ Card List ➔ Customer ➔ New 
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Gambar 4.2 Membuka menu untuk membuat kartu customer  

 

2. Setelah klik new akan muncul informasi informasi seperti 

gambar di atas yang harus diisikan, antara lain: 

a. Card Type : Isikan dengan tipe kartu yang akan dibuat, untuk 

kartu pelanggan maka pilih type Customer. 

b. Name : Isikan dengan nama pelanggan/customer 

c. Card ID : Isikan dengan kode pelanggan  

d. Address : Isikan dengan alamat dari pelanggan tersebut 

e. City : Isikan dengan kota domisili pelanggan   

f. State : Isikan dengan asal provinsi pelanggan 

g. Country : Isikan dengan negara domisili pelanggan 

h. Phone : Isikan dengan nomor telepon pelanggan 

i. Email : Isikan dengan alamat email pelanggan 
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Gambar 4.3 Tampilan card information untuk membuat daftar 

pelanggan 

 

3. Langkah berikutnya isikan beberapa informasi pada menu Selling 

Detais seperti di bawah ini: 

a. Sale Layout: Layout faktur yang diperlukan perusahaan untuk 

melakukan transaksi penjualan. Ada beberapa pilihan seperti 

No Default, Service, Item, Professional, Time Billing dan 

Miscellanous. Karena buku ini ditujukan untuk perusahaan 

jasa maka kita bisa memilih layout service. 

b. Income Account: Akun yang akan digunakan untuk 

perusahaan ketika akan melakukan penjualan. Akun ini 
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diisikan dengan akun yang terkait dengan pendapatan utama 

perusahaan. 

c. Tax Code: Diisi pajak pada saat melakukan penjualan. 

d. Freight Tax Code: Diisi pajak untuk beban angkut penjualan. 

 
Gambar 4.4 Tampilan Selling Details Untuk Pembuatan Kartu Piutang 

 

e. Customer Terms Infomation : 

1) Payment is Due: Isikan dengan informasi mengenai syarat 

pembayaran yang ditentukan perusahaan. Adapun contoh 

syarat pembayaran yaitu 2/10, n/30; 3/10, n/30; Net 30; 

Net 7 dan lain sebagainya. 
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a. In a Given # of days: Penjualan dengan  pembayaran 

akan dilakukan sesuai jumlah hari yang ditetapkan 

perusahaan 

b. C.O.D: Penjualan dengan pembayaran dilakukan secara 

tunai 

c. Prepaid: Penjualan dengan pembayaran dilakukan di 

muka sebelum  barang atau jasa diterima. 

d. On a Day of the Month: Penjualan dengan pembayaran 

akan dilakukan dengan tanggal sesuai yang ditetapkan 

perusahaan  

e.  # of Days of EOM: Penjualan dengan pembayaran akan 

dilakukan pada jumlah waktu hari setelah akhir bulan 

sesuai yang ditetapkan perusahaan. 

f. Day of Month after EOM: Penjualan dengn pembayaran 

dilakukan pada suatu tanggal setelah akhir bulan 

sesuai dengan yang ditetapkan perusahaan. 

2) Discount Days: Isikan dengan batasan jumlah hari untuk 

mendapatkan diskon 

3) Balance Due Days: Isikan dengan batasan jumlah hari 

jatuh tempo pembayaran piutang. 

4) % Discount for early Payment: Diisikan dengan jumlah 

persentase diskon apabila membayar lebih awal 

5) % Monthly Charge for Late Payment: Diisikan dengan 

jumlah persentase diskon apabila terlambat membayar. 

Klik OK untuk menyelesaikan proses pembuatan data 

pelanggan. Ulangi 3 langkah di atas sampai semua daftar 

pelanggan dibuat semua.  
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B. Mengisi Saldo Awal Kartu Piutang 

Langkah yang dilakukan setelah membuat semua kartu pelanggan 

adalah pencatatan saldo awal kartu piutang. Pencatatan saldo awal 

buku pembantu piutang/kartu piutang ini dilakukan untuk 

mengecek kesamaan total semua kartu piutang dengan saldo akun 

Piutang Usaha (Account Receivable). Berikut daftar saldo piutang 

yang akan dijadikan contoh kasus dalam modul ini: 

Kode Nama 

Customer 

No 

Faktur 

Tanggal 

Faktur 

Syarat Saldo 

Piutang 

(Rp) 

C01 Panti Asuhan  “Al Ikhlas” 

FJ-

1511 

15/11/2017 2/10, 

n/30 

 3.350.000 

C02 Sanggar Tari  “Elmanda” 

FJ- 

2311 

23/11/2017 2/10, 

n/30 

 2.500.000 

C03 Klinik Sehat 

Usada 

FJ-

2511 

25/11/2017 2/10, 

n/30 

 4.690.000 

TOTAL  10.540.000 

 

Langkah–langkah untuk memasukkan saldo awal piutang: 

1. Klik Setup ➔ Balances ➔ Customer balances 

 
Gambar 4.5 Tampilan menu untuk entry saldo awal piutang 
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2. Pilih salah satu nama pelanggan yang akan diisi, misalnya Panti Asuhan “Al Ikhlas” lalu klik Add sale, 

 
Gambar 4.6 Mengaktifkan kartu pelanggan dan mengisi saldo 

 

3. Lalu klik enter untuk memunculkan historical sale 

 
Gambar 4.7 Tampilan historical sale 
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Pada historical sale ini yang harus diisikan adalah : 

a. Invoice: Isikan dengan No faktur 

b. Date: Isikan dengan tanggal faktur 

c. Memo: Isi memo dengan Saldo Awal Piutang 

d. Total Including Tax: Isikan dengan jumlah saldo piutang 

e. Tax Code: Isikan dengan pajak yang digunakan saat terjadinya 

piutang. Jika tidak ada pajak maka bisa diisi N-T. 

Pada saat semua data terisi, klik record. Isikan sampai 

semua saldo piutang pelanggan terisi semua. Apabila seluruh 

saldo piutang telah di-entry, maka akan nampak gambar seperti 

di bawah ini. Dimana Out Of Balance Amount Rp0.00 dan muncul 

Congratulation. Klik close jika selesai. 

 
Gambar 4.8 Tampilan setelah selesai memasukkan saldo awal piutang 

 

C. Membuat Data Pemasok 

Langkah yang harus dilakukan untuk dapat mengentry saldo awal 

utang adalah membuat beberapa data pemasok/supplier pada 
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perusahaan jasa. Data yang akan digunakan sebagai contoh kasus 

pada modul ini adalah: 

Kode Nama 

Supplier 

Alamat 

S01 Angkasa 

Elektronik 

Jl. Raden Patah No.19E Madiun-Jawa Timur 

No Telp: 0361-979789 

Email: angkasaelektronik@gmail.com 

S02 Toko Bersih Jl. Raden Umar No.97A Madiun-Jawa Timur 

No Telp: 0361-379689 

Email: tokobersih@gmail.com 

S03 Toko Mesti 

Lengkap 

Jl.Ahmad Yani  No 05 Madiun-Jawa Timur 

No Telp: 0361-309683 

Email: tokomestilengkap@gmail.com 

 

Langkah- langkah membuat data pemasok/supplier: 

1. Membuka Card File ➔ Card List ➔ Supplier ➔ New 

 
Gambar 4.9 Tampilan membuka menu untuk membuat pemasok 
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2. Setelah klik new akan muncul informasi informasi seperti 

gambar di atas yang harus diisikan, antara lain : 

a. Card Type : Isikan dengan tipe kartu yang akan dibuat, untuk 

kartu pemasok maka pilih type Supplier. 

b. Name : Isikan dengan nama pemasok supplier 

c. Card ID : Isikan dengan kode pemasok 

d. Address : Isikan dengan alamat dari pemasok tersebut 

e. City : Isikan dengan kota domisili pemasok   

f. State : Isikan dengan asal provinsi pemasok 

g. Country : Isikan dengan negara domisili pemasok 

h. Phone : Isikan dengan nomor telepon pemasok  

i. Email : Isikan dengan alamat email pemasok 

 
Gambar 4.10 Tampilan card information untuk membuat daftar 

pemasok 
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3. Setelah itu isikan beberapa informasi pada menu Buying Details 

seperti di bawah ini: 

 
Gambar 4.11 Tampilan buying details untuk pemasok 

 

a. Purchase Layout: Layout faktur yang diperlukan perusahaan 

untuk melakukan transaksi penmbelian. Ada beberapa 

pilihan seperti No Default, Service, Item, Professional, Time 

Billing dan Miscellanous. 

b. Expense Account: Akun yang akan digunakan untuk 

perusahaan ketika akan melakukan pembelian. Akun ini 

diisikan dengan opsi kebijakan yang ditetapkan perusahaan. 

c. Tax Code: Diisi pajak pada saat melakukan pembelian. 

d. Freight Tax Code: Diisi pajak untuk beban angkut pembelian. 
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e. Customer Terms Infomation: 

1) Payment is Due: Isikan dengan informasi mengenai syarat 

pembayaran yang ditentukan perusahaan 

a) In a Given # of days: Pembelian dengan pembayaran 

akan dilakukan sesuai jumlah hari yang ditetapkan 

perusahaan 

b) C.O.D: Pembelian dengan pembayaran dilakukan 

secara tunai 

c) Prepaid: Pembelian dengan pembayaran dilakukan di 

muka sebelum  barang atau jasa diterima. 

d) On a Day of the Month: Pembelian dengan pembayaran 

akan dilakukan dengan tanggal sesuai yang ditetapkan 

perusahaan  

e) # of Days of EOM: Pembelian dengan Pembayaran akan 

dilakukan pada jumlah waktu hari setelah akhir bulan 

sesuai yang ditetapkan perusahaan. 

f) Day of Month after EOM: Pembelian dengan 

pembayaran dilakukan pada suatu tanggal setelah 

akhir bulan sesuai dengan yang ditetapkan 

perusahaan. 

2) Discount Days: Isikan dengan batasan jumlah hari untuk 

mendapatkan diskon 

3) Balance Due Days: Isikan dengan batasan jumlah hari jatuh 

tempo pembayaran utang. 

4) % Discount for early Payment: Diisikan dengan jumlah 

presentase diskon apabila membayar lebih awal. 
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5) % Monthly Charge for Late Payment: Diisikan dengan 

jumlah persentase diskon apabila terlambat membayar. 

Klik OK untuk menyelesaikan proses pembuatan data 

pelanggan. Ulangi 3 langkah di atas sampai semua daftar 

pemasok dibuat semua. 

 

D. Mengisi Saldo Awal Kartu Utang 

Setelah membuat semua kartu pemasok, langkah selanjutnya adalah 

pencatatan saldo awal kartu utang. Pencatatan saldo awal buku 

pembantu utang/kartu utang ini dilakukan nuntuk mengecek 

kesamaan total semua kartu utang dengan  saldo akun Utang Usaha 

(Account Payable). Berikut daftar saldo utang yang akan dijadikan 

contoh kasus dalam modul ini: 

Kode Nama 

Supplier 

No 

Faktur 

Tanggal 

Faktur 

Syarat Saldo 

Utang 

(Rp) 

S01 Angkasa 

Elektronik 

FKE.15 10/11/2017 2/10, n/30 2.510.000 

S02 Toko Bersih FDA.28 20/11/2017 2/10, n/30 5.001.000 

S03 Toko Mesti 

Lengkap 

FSM.33 25/11/2017 2/10, n/30 2.251.000 

TOTAL 9.762.000 

 

Langkah –langkah untuk mengentri saldo awal piutang: 

1. Klik Setup ➔ Balances ➔ Supplier Balances 
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Gambar 4.12 Tampilan cara membuka menu untuk entry saldo awal 

utang 

 

2. Pilih salah satu nama pelanggan yang akan diisi, misalnya 

Angkasa Elektronik lalu klik Add Purchase 

 
Gambar 4.13 Mengaktifkan kartu pelanggan dan mengisi saldo 
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3. Lalu tekan enter untuk memunculkan historical purchase: 

 
Gambar 4.14 Tampilan historical purchase 

 

4. Pada historical purchase ini yang harus diisikan adalah: 

a. PO #: Isikan dengan nomor pesanan pembelian 

b. Date: Isikan dengan tanggal faktur 

c. Supplier Inv #: Isikan dengan nomor faktur dari pemasok 

d. Memo: Isi memo dengan Saldo Awal Utang 

e. Total Including Tax: Isikan dengan jumlah saldo utang  

f. Tax Code: Isikan dengan jenis pajak yang digunakan saat 

terjadinya piutang. Jika tidak ada bisa diisi N-T. 

g. Job: Isikan daftar Job yang ada yang dikenakan ada transaksi. 

5. Pada saat semua data terisi klik Record. Isikan sampai semua 

saldo utang pemasok terisi semua. Apabila seluruh saldo utang 

telah dientry, maka Out Of Balance Amount Rp 0.00 dan muncul 

Congratulation. Klik close jika selesai. 
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BAB V 

Mengelola Kartu Perlengkapan, 

Peralatan, dan Item Jasa 
 

 

Setelah mempelajari materi pada bab ini, siswa diharapkan: 

1. Mampu membuat daftar perlengkapan dan peralatan untuk 

perusahaan jasa. 

2. Mampu mmembuat daftar  item jasa untuk perusahaan jasa. 

3. Mampu mengentry harga pokok perlengkapan dan peralatan untuk 

perusahaan jasa. 

4. Mampu mengentry harga pokok  item jasa yang dijual untuk setiap 

jasa. 

 

 

Fitur inventory berhubungan dengan persediaan dan berguna untuk 

mengelola persediaan perlengkapan dalam sebuah perusahaan. 

Pengelolaan ini dimaksudkan untuk pengendalian dan juga pengawasan 

terhadap persediaan perusahaan. 

A. Membuat Daftar Perlengkapan 

Sebelum menggunakan fitur Inventory, kita membuat daftar persediaan 

baik perlengkapan, peralatan, maupun item jasa yang ditawarkan oleh 

perusahaan. Berikut data perlengkapan perusahaan yang digunakan. 

Kode Nama Perlengkapan Quantity Harga 

Beli (Rp) 

Jumlah 

(Rp) 

Per-01 Detergen “Rinso Molto 900gr” 30 Buah 26.000 780.000 

Per-02 Detergen “ Daia Putih 900 gr” 20 Buah 21.000  420.000 

Per-03 Pemutih “ Bayclin Lemon 500 15 Botol 10.000 150.000 
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Kode Nama Perlengkapan Quantity Harga 

Beli (Rp) 

Jumlah 

(Rp) ml” 

Per-04 Pelicin Pakaian” Rapika 450 ml” 

20 Botol 10.000 200.000 

Per-05 Pewangi “Molto 450 ml” 25 Botol 12.000 300.000 

Per-06 Softener “ SoKlin 900 ml” 10 Botol 25.000 250.000 

Per-07 Plastik merah besar 250 lmbr 2.000 500.000 

Per-08 Plastik hitam sedang 200 lmbr 1.500 300.000 

Per-09 Kertas Nota 4 rim 50.000 200.000 

Per-10 Isolasi 5 roll 17.000    85.000 

Per-11 Steples 3 buah 30.000    90.000 

Total  3.275.000 

 

Langkah membuat daftar persediaan perlengkapan adalah: 

1. Klik fitur Inventory ➔ Item List ➔ New 

 
Gambar 5.1 Membuat Daftar Perlengkapan 

 

2. Isikan informasi terkait profil persediaan perlengkapan yang 

akan dibuat. 



73 

 

 
Gambar 5.2 Mengisi informasi daftar perlengkapan 

 

Adapun informasi yang perlu kita ketahui: 

a. Item Number: diisi dengan kode perlengkapan yang akan 

dibuat. 

b. Name: diisi dengan nama perlengkapan yang akan dibuat. 

c. Beri tanda centang dengan meng-klik kolom kotak pada sisi 

kiri tulisan I Buy This Item dan I Inventory This Item. Lalu atur 

linked account nya ke akun Perlengkapan.  

I Buy This Item dan I Inventory This Item dicentang karena 

perlengkapan hanya dibeli dan sebagai stok untuk digunakan, 

tidak untuk dijual. 

d. Asset Account for Item Inventory: diisi dengan akun 

Perlengkapan / Supplies. Asset Account for Item  Inventory 

merupakan jenis akun aset yang digunakan untuk item 
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persediaan yang dibuat. Karena dalam sub bab ini kita 

membuat persediaan perlengkapan, maka kita arahkan pada 

akun perlengkapan. 

3. Selanjutnya, klik tab Buying Details. Isikan informasi terkait 

Detail Pembelian. 

 
Gambar 5.3 Mengisi informasi buying details 

 

Adapun informasi pada Buying Details yang perlu kita 

ketahui saat mengisi: 

a. Standard Cost: diisi dengan harga beli atau harga rata-rata 

pembelian perlengkapan tersebut. 

b. Buying Unit of Measure: diisi dengan satuan barang 

perlengkapan yang dibeli. 

c. Number of Items per Buying Unit: diisi dengan jumlah 

minimum pada saat pembelian perlengkapan. 
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d. Tax Code When Bought: diisi dengan pajak yang digunakan 

pada saat pembelian. 

e. Minimum Level for Restocking Alert: diisikan dengan jumlah 

minimum persediaan perlengkapan yang ada sebelum 

dilakukan pemesanan kembali. 

f. Primary Supplier for Reorder: diisikan dengan pemasok utama 

dari persediaan perlengkapan tersebut. 

g. Supplier Item Number: diiskan dengan kode persediaan 

perlengkapan dari pemasok. 

h. Default Reorder Quantity: diisikan dengan jumlah standar 

setiap pemesanan perlengkapan. 

4. Klik OK. 

 

B. Mengisi Saldo Awal Perlengkapan 

Langkah selanjutnya setelah memasukkan daftar perlengkapan 

adalah memasukkan saldo awal dari perlengkapan yang diperoleh 

dari neraca saldo periode sebelumnya. Langkah-langkah untuk 

memasukkan saldo awal perlengkapan adalah sebagai berikut: 

1. Klik Inventory ➔ Adjust Inventory 

2. Lalu, akan muncul tampilan seperti gambar 5.4. Isikan informasi 

terkait saldo awal perlengkapan satu persatu. Adapun informasi 

yang perlu kita ketahui saat mengisi saldo awal: 

a. Inventory Journal Number: diisi dengan nomor jurnal 

perlengkapan, jika ada. 

b. Date: diisi dengan tanggal awal memasukkan saldo awal. 

c. Memo: diisi dengan catatan, seperti Saldo Awal Perlengkapan. 

d. Item Number: diisi dengan kode perlengkapan 
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e. Quantity: diisi dengan kuantitas awal perlengkapan. 

f. Unit Cost: diisi dengan harga satuan pembelian perlengkapan 

g. Amount: tidak perlu diisi karena nanti akan otomatis terisi 

dengan total harga satuan dikali dengan kuantitas awal. 

Account: diisi dengan akun perlengkapan. 

 
Gambar 5.4 Mengisi saldo awal perlengkapan 

 

3. Langkah terakhir, klik Record. 

Adapun cara lain yang dapat kita gunakan saat mengisi saldo 

awal perlengkapan: 

1. Klik Inventory ➔ Count Inventory 

2. Akan muncul tampilan seperti ini. Isikan jumlah awal 

perlengkapan pada kolom Counted. HANYA PADA 

PERLENGKAPAN. 
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Gambar 5.5 Mengisi jumlah awal persediaan perlengkapan 

 

3. Klik Adjust Inventory, maka akan muncul tampilan seperti 

gambar di bawah ini. Isi kolom Default Adjustment Account 

dengan akun yang terkait dengan Perlengkapan. 

 
Gambar 5.6 Menyesuaikan akun perlengkapan 
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4. Klik Continue ➔ Opening Balances 

5. Kemudian, muncul tampilan seperti gambar di bawah ini. Isikan 

informasi yang terkait dan juga nominal saldo awal perlengkapan 

pada kolom Unit Cost. 

 
Gambar 5.7 Mengisi saldo awal perlengkapan 

 

6. Isikan informasi saldo awal perlengkapan pada form yang 

disediakan. 

7. Klik Record. 

 

C. Membuat Daftar Peralatan 

Berikut daftar peralatan yang dipakai pada perusahaan ini. 

Kode Nama Peralatan 
Kuan-

titas 

Satu

an 

Harga Jumlah 

(Rp) (Rp) 

Alat-01 Mesin Cuci “Panasonic Twin Tub” 

3 Unit 3.700.000 11.100.000 

Alat-02 Mesin Cuci “LG Top 4 Unit 7.140.000 28.560.000 



79 

 

Kode Nama Peralatan 
Kuan-

titas 

Satu

an 

Harga Jumlah 

(Rp) (Rp) Load” 

Alat-03 Setrika “Panasonic” 5 Unit 330.000 1.650.000 

Alat-04 AC “Panasonic” 2 Unit 5.090.000 10.180.000 

Alat-05 Meja Setrika “Tobi” 5 Unit 240.000 1.200.000 

Alat-06 Jemuran 5 Unit 470.000 2.350.000 

Alat-07 Laptop Asus 1 Unit 5.998.000 5.998.000 

Alat-08 Printer Canon Pixma 1 Unit 1.398.000 1.398.000 

Alat-09 Meja 1 Unit 700.000 700.000 

Alat-10 Kursi 10 Unit 150.000 1.500.000 

Alat-11 Rak 3 Unit 928.000 2.784.000 

Alat-12 Kalkulator 1 Unit 250.000 250.000 

TOTAL 67.670.000 
 

Kita dapat memasukkan bagian peralatan setelah memasukkan saldo 

awal perlengkapan. Cara membuat daftar peralatan sama dengan ketika 

membuat daftar perlengkapan. Langkah-langkah membuat daftar 

peralatan adalah sebagai berikut: 

1. Klik Inventory ➔ Item List ➔ New 

 
Gambar 5.8 Membuat daftar peralatan 
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2. Isikan informasi terkait profil persediaan peralatan yang akan 

dibuat. 

 
Gambar 5.9 Mengisi informasi daftar peralatan 

 

Adapun informasi yang perlu kita ketahui : 

a. Item Number: diisi dengan kode peralatan yang akan dibuat. 

b. Name: diisi dengan nama peralatan yang akan dibuat. 

c. Beri tanda centang dengan mengeklik kolom kotak pada sisi 

kiri tulisan I Buy This Item dan I Inventory This Item. Lalu atur 

linked account nya ke akun Peralatan. I Buy This Item dan I 

Inventory This Item dicentang karena peralatan hanya dibeli 

dan sebagai stok untuk digunakan, tidak untuk dijual. 

d. Asset Account for Item Inventory: diisi dengan akun 

Peralatan/Equipment at Cost. 
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3. Klik tab Buying Details. Isikan informasi terkait Detail 

Pembelian. 

 
Gambar 5.10 Mengisi informasi buying details 

 

Adapun informasi pada Buying Details yang perlu kita ketahui 

saat mengisi: 

a. Standard Cost: diisi dengan harga beli atau harga rata-rata 

pembelian peralatan tersebut. 

b. Buying Unit of Measure: diisi dengan satuan barang peralatan 

yang dibeli. 

c. Number of Items per Buying Unit: diisi dengan jumlah 

minimum pada saat pembelian peralatan. 
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d. Tax Code When Bought: diisi dengan pajak yang digunakan 

pada saat pembelian. 

4. Klik OK. 

 

D. Mengisi Saldo Awal Peralatan 

Langkah selanjutnya adalah memasukkan saldo nominal awal dari 

peralatan yang didapat dari saldo akhir bulan sebelumnya. Langkah-

langkah untuk memasukkan saldo awal peralatan sama dengan 

ketika memasukkan saldo awal perlengkapan sebagai berikut: 

1. Klik Inventory ➔ Adjust Inventory 

 
Gambar 5.11 Tampilan awal adjust inventory 

 

2. Lalu, akan muncul tampilan seperti gambar 5.12. Isikan informasi 

terkait saldo awal peralatan satu persatu. Adapun informasi yang 

perlu kita ketahui saat mengisi saldo awal: 

a. Inventory Journal Number: diisi dengan nomor jurnal 

peralatan, jika ada. 

b. Date: diisi dengan tanggal awal memasukkan saldo awal. 
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c. Memo: diisi dengan catatan, seperti Saldo Awal Peralatan. 

d. Item Number: diisi dengan kode peralatan 

e. Quantity: diisi dengan kuantitas awal peralatan. 

f. Unit Cost: diisi dengan harga satuan pembelian peralatan 

g. Amount: tidak perlu diisi karena nanti akan otomatis terisi 

dengan total harga satuan dikali dengan kuantitas awal. 

h. Account: diisi dengan akun peralatan. 

 
Gambar 5.12 Mengisi saldo awal peralatan 

 

3. Langkah terakhir, klik Record. 

Adapun cara lain yang dapat kita gunakan saat mengisi saldo 

awal peralatan: 

1. Klik Inventory ➔ Count Inventory 

2. Akan muncul tampilan seperti ini. Isikan jumlah awal peralatan 

pada kolom Counted. HANYA PADA PERALATAN. 
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Gambar 5.13 Mengisi jumlah awal peralatan 

 

3. Klik Adjust Inventory, maka akan muncul tampilan seperti 

gambar di bawah ini. Isi kolom Default Adjustment Account 

dengan akun yang terkait dengan Peralatan. 

 
Gambar 5.14 Menyesuaikan akun peralatan 
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4. Klik Continue ➔ Opening Balances 

5. Kemudian, muncul tampilan seperti gambar di bawah ini. Isikan 

informasi yang terkait dan juga nominal saldo awal peralatan 

pada kolom Unit Cost. 

 
Gambar 5.15 Mengisi saldo awal peralatan 

 

6. Klik Record. 

 

E. Membuat Daftar Item Jasa yang Dijual 

Berikut adalah daftar item jasa yang dijual pada perusahaan ini. 

Kode Nama Jasa Keterangan Satuan Harga (Rp) 

LON-1 Laundry Komplit Cuci+Kering+Setrika KG 10.000 

LON-2 Laundry Kering Setrika Saja KG 8.000 

LON-3 Paket Hemat 

Komplit 

Cuci+Kering+Setrika 50KG 220.000 

LON-4 Paket Hemat 

Setrika 

Setrika Saja 50KG 190.000 
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Setelah memasukkan saldo awal perlengkapan dan juga peralatan. 

Langkah selanjutnya kita memasukkan untuk bagian daftar item jasa 

yang dijual. Cara membuat daftar item jasa yang dijual sama dengan 

ketika membuat daftar perlengkapan maupun daftar peralatan. 

Langkah-langkah membuat daftar item jasa yang dibuat adalah 

sebagai berikut: 

1. Klik Inventory ➔ Item List ➔ New 

2. Isikan informasi terkait profil item jasa yang dijual yang akan 

dibuat. 

 
Gambar 5.16 Mengisi daftar item jasa yang dijual 

 

Adapun informasi yang perlu kita ketahui: 

a. Item Number: diisi dengan kode item jasa yang akan dibuat. 
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b. Name: diisi dengan nama item jasa yang akan dibuat. 

c. Beri tanda centang dengan mengeklik kolom kotak pada sisi 

kiri tulisan I Sell This Item. Lalu atur linked account nya ke 

akun Pendapatan/Income. 

Untuk informasi terkait I Buy This Item dan I Inventory This 

Item tidak dicentang karena jasa hanya dijual. 

d. Income Account for Tracking Sales: diisi dengan akun 

Pendapatan/Service Income. 

Klik Tab Selling Details. Isikan Informasi terkait Detail 

Penjualan.  

 
Gambar 5.17 Mengisi informasi selling details 
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Adapun informasi pada Selling Details yang perlu kita ketahui 

saat mengisi: 

a. Base Selling Price: diisi dengan harga jual dasar pada itemjasa 

yang dijual. 

b. Selling Unit of Measure: disi dengan satuan item jasa yang 

dijual. 

c. Tax Code When Bought: diisi dengan pajak yang digunakan 

pada saat penjualan. 

 

3. Klik OK. 
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BAB VI 

TRANSAKSI PEMBELIAN 

UNTUK PERUSAHAAN JASA 
 

 

Setelah mempelajari materi pada bab ini, siswa diharapkan: 

1. Mampu menjelaskan entry transaksi pembelian perlengkapan 

secara tunai maupun kredit, transaksi retur pembelian 

perlengkapan secara tunai maupun kredit, dan transaksi pelunasan 

utang bagi perusahaan jasa. 

2. Mampu mengentry transaksi pembelian perlengkapan secara tunai 

maupun kredit, transaksi retur pembelian perlengkapan secara 

tunai maupun kredit dan transaksi pelunasan utang bagi 

perusahaan jasa. 

3. Mampu mengecek kebenaran jurnal pembelian, retur pembelian, 

dan pelunasan utang. 

 

 

Aplikasi MYOB menyediakan menu untuk pencatatan transaksi yang 

berkaitan dengan pembelian yaitu menu Purchases. 

1. Purchases Register: Menu ini digunakan untuk menampilkan 

rekapan jurnal dari seluruh transaksi yang berkaitan dengan 

pembelian. 

2. Pay Bills: Menu ini digunakan untuk memasukkan transaksi 

pembayaran utang kepada pemasok/supplier. 
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3. Enter Purchase: menu ini digunakan untuk memasukkan transaksi 

pembelian baik secara tunai maupun secara kredit.  

4. Print/Email Purchase Orders: menu ini digunakan untuk 

mengemail/mencetak daftar pesanan yang telah dibuat kepada 

supplier/pemasok. 

5. Print/Email Remittance Advices: menu digunakan untuk 

mengemail/mencetak nota pembayaran kepada supplier/pemasok. 

6. Transaction Jurnal: Menu ini digunakan untuk melihat hasil semua 

jurnal yang telah dimasukkan.  

 
Gambar 6.1 Tampilan menu purchases 

 

A. Pencatatan Transaksi Pembelian Secara Tunai 

Berikut bukti pembelian secara tunai pada perusahaan yang harus 

dicatat. 
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Langkah–langkah untuk memasukkan transaksi pembelian secara 

tunai adalah sebagai berikut: 

1. Klik menu Purchase ➔ Enter Purchase 

 
Gambar 6.2 Tampilan menu enter purchase 
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2. Pilih salah satu jenis tahapan transaksi pembelian yang akan 

dimasukkan pada tanda panah putih. 

 
Gambar 6.3 Tampilan memilih tahapan transaksi pembelian 

 

Pada opsi tersebut ada beberapa pilihan: 

a. Quote: Digunakan apabila perusahaan hanya ingin membuat 

daftar pesanan saja 

b. Order: Digunakan apabila perusahaan telah mengirimkan 

surat pesanan barang kepada pemasok 

c. Bill: Digunakan apabila perusahaan menerima tagihan atas 

pembelian yang dilakukannya.  

Jika pada soal tidak terdapat keterangan proses pembelian 

pada tahap apa maka bisa diasumsikan bahwa transaksi 

pembelian tersebut berupa tagihan yang diterima dari pemasok. 

3. Klik pada tanda yang ditunjuk panah putih untuk memilih nama 

pemasok. 
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Gambar 6.4 Tampilan memilih nama pemasok 

 

Pilih pemasok Toko Bersih (menyesuaikan di soal yang akan 

dikerjakan), lalu pilih Use Supplier.  

4. Karena transaksi pembelian tunai, maka termin harus diubah ke  

C.O.D. 

 
Gambar 6.5 Mengubah termin 
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Cara mengubah terminnya yaitu klik tanda panah putih di 

samping tulisan terms lalu akan muncul tampilan Credit Terms, 

pilih Payment is Due ke C.O.D lalu klik OK.  

5. Isikan informasi terkait pembelian barang sebagai berikut: 

 
Gambar 6.6 Melengkapi informasi pembelian 

 

a. Ceklis pada Tax Inclusive disesuaikan dengan soal. Jika harga 

dalam faktur di soal sudah termasuk PPN 10%, maka ceklist 

tetap dicentang. Namun, jika faktur dalam soal belum 
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termasuk PPN maka ceklist dihilangkan agar dapat 

diperhitungkan pada kolom Tax dibawah oleh sistem. 

b. Purchase # diisi dengan No faktur pembelian 

c. Date diisi dengan tanggal terjadinya transaksi 

d. Bill diisi dengan jumlah barang yang dibeli 

e. Item Number diisi dengan kode nama barang yang dibeli  

f. Description akan otomatis terisi setelah mengisi kolom Item 

Number 

g. Price diisi dengan harga satuan barang yang dibeli 

h. Total meupakan jumlah tagihan yang akan otomatis terisi 

setelah mengisi kolom price 

i. Tax diisi dengan pajak yang digunakan dalam transaksi 

pembelian bila tidak ada bisa diisi N-T, bila ada pilih PPN 

j. Freight diisi jika terdapat biaya angkut dalam pembelian 

tersebut. Jika tidak ada maka tidak perlu diisi 

k. Kolom Paid Today harus diisi sesuai dengan nominal di total 

amount, karena pembelian ini dilakukan secara tunai. 

6. Langkah cek kebenaran jurnal adalah klik Ctrl+R, dan akan 

muncul tampilan seperti pada Gambar 6.7. 

7. Setelah itu klik Ok lalu Record.  
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Gambar 6.7 Tampilan jurnal transaksi pembelian tunai 

 

B. Pencatatan Transaksi Pembelian Secara Kredit 
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Langkah-langkah memasukkan transaksi pembelian kredit: 

1. Klik menu Purchase ➔ Enter Purchase. 

2. Klik pada tanda yang ditunjuk panah putih untuk memilih nama 

pemasok. 

 
Gambar 6.8 Tampilan memilih nama pemasok 

 

3. Pilih pemasok Angkasa Elektronik (menyesuaikan di soal yang 

akan dikerjakan), lalu pilih Use Supplier. 

4. Isikan Informasi terkait pembelian barang sebagai berikut: 

a. Ceklist pada Tax Inclusive disesuaikan dengan soal. Jika harga 

dalam faktur di soal sudah termasuk PPN 10%, maka ceklist 

tetap dicentang. Namun, jika faktur dalam soal belum 

termasuk PPN maka ceklist dihilangkan agar dapat 

diperhitungkan pada kolom Tax dibawah oleh sistem. 
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Gambar 6.9 Melengkapi informasi pembelian 

 

b. Terms bisa disesuaikan dengan soal, jika sudah sesuai tidak 

perlu diubah, bila belum sesuai bisa diubah dengan mengklik tanda panah putih disamping “Terms”. 
c. Purchase # diisi dengan No faktur pembelian. 

d. Date diisi dengan tanggal terjadinya transaksi. 

e. Bill diisi dengan jumlah barang yang dibeli. 

f. Item Number diisi dengan kode nama barang yang dibeli. 

g. Description akan otomatis terisi setelah mengisi kolom Item 

Number. 



99 

 

h. Price diisi dengan harga satuan barang yang dibeli. 

i. Total merupakan jumlah tagihan yang akan otomatis terisi 

setelah mengisi kolom price. 

j. Tax  diisi dengan pajak yang digunakan dalam transaksi 

pembelian bila tidak ada bisa diisi N-T, bila ada pilih PPN. 

k. Freight diisi jika terdapat biaya angkut dalam pembelian 

tersebut. Jika tidak ada maka tidak perlu diisi. 

5. Langkah cek kebenaran jurnal adalah klik Ctrl+R, dan akan 

muncul tampilan sebagai berikut: 

 
Gambar 6.10 Tampilan jurnal transaksi pembelian kredit 

 

6. Setelah itu klik Ok lalu Record.  
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C. Pencatatan Transaksi Retur Pembelian Secara Tunai 

 

 

Langkah memasukkan transaksi retur pembelian tunai sebagai 

berikut: 

1. Klik menu Purchases ➔ Enter Purchase. 

2. Pilih nama Supplier yaitu: Toko Angkasa Elektronik klik Use 

Supplier. 
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Gambar 6.11 Memilih supplier 

 

3. Isikan informasi retur pembelian sesuai dengan tampilan di 

bawah ini: 

 
Gambar 6.12 Melengkapi informasi retur pembelian 
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Pada kolom Bill beri tanda minus (-) sehingga price, Tax, dan 

Total Amount berisi tanda kurung “(  )” dengan tujuan 
mengurangi jumlah barang yang telah dibeli.  

4. Langkah cek kebenaran jurnal, tekan CTRL+R sehingga muncul 

Recap Transaction berikut. 

 
Gambar 6.13 Tampilan recap transaction retur pembelian tunai 

 

5. Jika sudah klik OK pada Recap Transaction kemudian Record 

transaksi.  

Setelah transaksi di-record, selanjutnya adalah mencatat 

pengembalian kas yang telah dibayarkan karena pembelian 

dilakukan secara tunai dengan cara berikut: 
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1. Klik Register pada jendela Purchase ➔ Enter Purchase. 

 
Gambar 6.14 Tampilan register 

 

2. Pilih Return & Debits pada jendela Purchase Register lalu klik 

Receive Refund. 

 
Gambar 6.15 Tampilan return & debits 
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3. Lengkapi Settle Returns & Debits seperti tampilan di bawah ini : 

 
Gambar 6.16 Tampilan settle return & debits 

 

Adapun informasi yang harus diisikan, antara lain: 

a. Deposit to Account: diarahkan pada sumber akun untuk 

pengembalian kas. 

b. Amount Received: berisi nominal uang yang akan diterima 

kembali. 

c. Payment Method: diisikan dengan metode penerimaan yang 

digunakan. 

d. Memo: diisi dengan keterangan transaksi. 

e. ID #: diisi dengan nomor bukti transaksi. 

f. Date: diisi dengan tanggal transaksi. 

4. Sebelum di-record, langkah cek kebenaran jurnal tekan CTRL+R 

sehingga ditampilkan Recap Transaction berikut: 
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Gambar 6.17 Recap transaction penerimaan kembali uang 

 

5. Jika sudah benar klik Ok, lalu Record 

 

D. Pencatatan Transaksi Retur Pembelian Secara Kredit 

 

Langkah memasukkan transaksi retur pembelian kredit sebagai 

berikut: 

1. Klik menu Purchases ➔ Enter Purchase. 

2. Pilih nama Supplier yaitu : Angkasa Elektronik  lalu klik Use 

Supplier. 
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Gambar 6.18 Memilih supplier 

 

3. Isikan informasi retur pembelian kredit sesuai dengan tampilan 

di bawah ini: 

 
Gambar 6.19 Melengkapi informasi retur pembelian 
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Pada kolom Bill beri tanda minus (-) sehingga price, Tax, dan 

Total Amount berisi tanda kurung “(  )” dengan tujuan 
mengurangi jumlah barang yang telah dibeli.  

4. Langkah cek kebenaran jurnal, tekan CTRL+R sehingga muncul 

Recap Transaction berikut. 

 
Gambar 6.20 Tampilan recap transaction retur pembelian kredit 

 

5. Jika sudah klik OK pada Recap Transaction kemudian Record 

transaksi.  

Setelah transaksi di-Record, selanjutnya adalah mencatat 

pengurangan utang pada buku pembantu utang dengan cara sebagai 

berikut: 

1. Klik Register pada jendela Purchase ➔ Enter Purchase. 
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Gambar 6.21 Tampilan register 

 

2. Pilih Return & Debits pada jendela Purchase Register lalu klik 

Apply to Purchase. 

 
Gambar 6.22 Tampilan return & debits 
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3. Lengkapi Settle Returns & Debits seperti tampilan di bawah ini: 

 
Gambar 6.23 Tampilan settle return & debits 

 

Klik Amount applied sejajar dengan transaksi pembelian yang 

diretur, dengan memperhatikan No Faktur, tanggal dan jumlah 

pada kolom Amount. 

4. Klik Record apabila jumlah Out of Balance sudah Rp0,00,-. 

 

E. Pencatatan Pelunasan Utang 

Pembelian secara kredit akan menimbulkan terjadinya utang. Setiap 

perusahaan mempunyai kebijakan untuk pembayarannya: 

a. Pembayaran tepat waktu sesuai batas waktunya. 

b. Pembayaran lebih awal sehingga menimbulkan diskon. 
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c. Pembayaran melewati batas waktu sehingga menimbulkan 

denda. 

 

Langkah-langkah memasukkan transaksi pelunasan utang: 

1. Pada menu Purchase pilih Pay Bills 

 
Gambar 6.24 Tampilan membuka pay bills 
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2. Tentukan rekening yang akan digunakan untuk membayar utang, 

pada contoh soal di atas menggunakan bank mandiri. Tentukan 

nama supplier yang akan dibayar tagihannya yaitu Toko Mesti 

Lengkap. 

 
Gambar 6.25 Tampilan memilih account dan supplier 

 

Lengkapi Informasi mengenai tagihan utang dari supplier 

tersebut. Adapun informasi yang perlu diisi, antara lain: 

a. Pay from Account: diarahkan ke sumber akun yang digunakan 

untuk melakukan pembayaran. 

b. Supplier: diarahkan ke nama pemasok yang akan dilunasi 

hutangnya. 
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c. Cheque No.: diisikan dengan nomor bukti transaksi. 

d. Date: diiskan dengan tanggal transaksi. 

e. Amount: diisikan dengan nominal hutang yang akan dibayar. 

f. Klik sejajar dengan hutang yang akan dibayar pada kolom 

Amount Applied. 

 
Gambar 6.26 Melengkapi informasi pay bills 

 

Karena pembayaran dilakukan lebih dari 10 hari batas waktu 

diskon (syarat 2/10, Net 30) maka pembayaran tidak disertai 

diskon/potongan. 
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3. Langkah cek kebenaran jurnal tekan CTRL+R, maka akan muncul 

Recap Transaction seperti di bawah ini. 

 
Gambar 6.27 Jurnal pelunasan utang 

 

4. Jika sudah benar klik OK pada Recap Transaction lalu klik 

Record. 
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BAB VII 

Transaksi Penjualan 

untuk Perusahaan Jasa 
 

 

Setelah mempelajari materi pada bab ini, siswa diharapkan: 

1. Mampu menjelaskan entry transaksi-transaksi penjualan tunai 

maupun kredit, retur penjualan, dan penerimaan pelunasan piutang 

bagi perusahaan jasa. 

2. Mampu mengentry transaksi-transaksi penjualan tunai maupun 

kredit, retur penjualan, dan penerimaan pelunasan piutang bagi 

perusahaan jasa. 

3. Mampu mengecek kebenaran jurnal penjualan tunai maupun kredit, 

retur penjualan, dan penerimaan pelunasan piutang bagi 

perusahaan jasa. 

 

Aplikasi MYOB menyediakan fitur Sales yang akan menangani transaksi 

penerimaan pesanan dari pelanggan, proses pembuatan faktur sampai 

dengan pelunasan piutang dari pelanggan. Menu Sales ini  dapat 

digunakan untuk mencatat transaksi penjualan, baik penjualan secara 

tunai maupun penjualan secara kredit. Pada menu Sales terdapat 

beberapa bagian dengan fungsi masing-masing sebagai berikut: 

1. Sales Register: digunakan pada saat ingin menampilkan semua 

rekap transaksi terkait penjualan. 

2. Enter Sales: digunakan saat memasukkan semua catatan transaksi 

terkait penjualan. 
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Gambar 7.1 Tampilan menu sales 

 

3. Receive Payment: digunakan saat mencatat pembayaran piutang 

dari pelanggan. 

4. Print/Email Statements: digunakan untuk mencetak atau melakukan 

email pernyataan (keterangan) terkait transaksi penjualan. 

5. Print/Email Invoice: digunakan untuk mencetak atau melakukan 

email faktur penjualan yang telah dibuat. 

6. Print Receipts: digunakan untuk mencetak bukti penerimaan 

pembayaran dari pelanggan. 

7. Transaction Journal: digunakan untuk melihat atau mencetak hasil 

dari pencatatan transaksi yang telah dilakukan yang berupa jurnal. 

Setelah memahami fungsi dari masing-masing bagian, maka kita 

bisa mulai memasukkan transaksi penjualan tunai, penjualan kredit, 

maupun pelunasan piutang. 
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A. Pencatatan Transaksi Penjualan Secara Tunai 

 

Adapun langkah-langkah yang dapat kita lakukan untuk mencatat 

transaksi penjualan secara tunai sebagai berikut: 

1. Klik fitur Sales ➔ Enter Sales. 

 
Gambar 7.2 Tampilan dalam enter sales 



118 

 

2. Pilih nama customer yang melakukan pemesanan jasa atau 

sudah melakukan penjualan dengan meng-klik tanda  pada 

kolom customer (lihat gambar 7.3). 

Pilih customer yang melakukan transaksi, lalu klik Use 

Customer. Jika customer yang melakukan transaksi belum 

ada dalam daftar, maka kita klik New ➔ Masukkan 

Informasinya (sesuaikan saja dengan apa yang ada). 

 
Gambar 7.3 Memilih customer 

 

3. Kemudian, akan muncul tampilan seperti pada gambar di 

bawah ini. Hilangkan tanda centang pada bagian Tax Inclusive 

jika transaksi yang digunakan sudah mengandung PPN. 

Karena kalau tidak dihilangkan, maka pajak yang akan 

dikenakan menjadi dobel. Sebaliknya, jika transaksi yang 
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digunakan belum mengandung PPN, maka klik centang pada 

Tax Inclusive. 

Jika layout masih ter-setting pada tampilan penjualan jasa, 

maka terlebih dahulu kita ubah layout form-nya dengan 

menjadi layout item dengan cara:  

a. Klik menu layout dibagian bawah kolom penjualan 

 
Gambar 7.4 Mengatur layout form 

 

b. Pilih layout item pada tampilan gambar 7.5, lalu klik OK. 
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Gambar 7.5 Mengubah layout form ke item 

 

 
Gambar 7.6 Menentukan tax inclusive 
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4. Atur syarat pembayaran dengan klik tanda panah di samping 

tulisan Terms. 

Gambar 7.7 Mengatur syarat pembayaran penjualan tunai 

 

Pada transaksi penjualan tunai dimana customer melakukan 

pembayaran secara langsung/tunai, maka kita hanya perlu 

mengisi pada bagian Payment is Due dengan pilihan C.O.D. 

5. Isikan informasi yang berkaitan dengan transaksi penjualan 

tunai yang dilakukan. Adapun informasinya sebagai berikut: 

a. Invoice#: diisi dengan nomor bukti fakturnya 

b. Date: diisi dengan tanggal terjadinya transaksi 

c. Customer PO#: diisi dengan nomor pesanan dari 

pelanggan. Jika tidak ada, abaikan saja kolom ini. 

d. Ship: diisi dengan jumlah jasa yang dijual kepada 

pelanggan. 
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Gambar 7.8 Mengisi informasi penjualan tunai 

 

e. Item Number: diisi dengan kode jasa yang dijual 

f. Description: akan terisi otomatis mengikuti kode jasa yang 

dipilih 

g. Price: diisi dengan harga jual jasa 

h. Disc%: diisi dengan potongan harga yang diberikan 

perusahaan pada pelanggan, jika ada. 

i. Total: akan terisi otomatis sejumlah harga dikalikan 

dengan jumlah jasa yang dijual 

j. Tax: diisi dengan kebijakan pajak yang diberlakukan di 

perusahaan ketika terjadinya penjualan. Jika perusahaan 
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mengambil PPN dari pelanggan, maka pada kolom tax diisi 

dengan PPN. Jika perusahaan tidak membebankan PPN 

kepada pelanggan, maka kolom tax diisi dengan N-T. 

k. Freight: diisi dengan jumlah biaya angkut yang 

dibebankan kepada pelanggan, jika ada. Jika biaya angkut 

ditanggung perusahaan, maka kolom ini dikosongkan saja. 

Jika biaya angkut dibebankan kepada pelanggan, pajak 

disebelah kolom freight dipilih PPN jika biaya angkut 

tersebut dikenai PPN, jika tidak dikenai PPN maka kolom 

pajak diisi N-T. 

l. Paid Today: diisi dengan jumlah pembayaran yang 

dilakukan pelanggan atau sejumlah dengan Total Amount. 

m. Pastikan kolom Balance Due adalah Rp 0,00. Klik Record. 

 

B. Pencatatan Transaksi Penjualan Secara Kredit 
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Langkah-langkah yang digunakan untuk mencatat transaksi penjualan 

kredit hampir sama seperti mencatat penjualan secara tunai. Langkah-

langkah untuk mencatat transaksi penjualan secara kredit adalah 

sebagai berikut: 

1. Klik Sales ➔ Enter Sales. 

2. Pilih nama customer yang melakukan pemesanan jasa atau sudah 

melakukan penjualan dengan mengeklik tanda  pada kolom 

customer. 

3. Pilih customer yang melakukan transaksi, lalu klik Use Customer. 

4. Hilangkan tanda centang pada bagian Tax Inclusive. Jika harga dalam 

faktur di soal sudah termasuk PPN 10%, maka ceklis tetap 

dicentang. Namun, jika faktur dalam soal belum termasuk PPN maka 

ceklist dihilangkan agar dapat diperhitungkan pada kolom Tax 

dibawah oleh sistem. 

5. Atur syarat pembayaran dengan klik tanda panah disamping tulisan 

Terms. 

 
Gambar 7.9 Mengatur syarat pembayaran penjualan kredit 
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Pada transaksi penjualan kredit, ada beberapa informasi yang 

harus diisi pada bagian syarat pembayaran ini. Informasi itu adalah: 

a. Payment is Due: diisi dengan opsi syarat pembayaran yang 

diberikan. Untuk syarat pembayaran seperti 2/10, net 30, maka 

diisi dengan In a Given # of Days. 

b. Discount Days: diisi dengan jumlah hari periode potongan 

harga/diskon 

c. Balance Due Days: diisi dengan jumlah hari jatuh tempo 

pelunasan piutang 

d. % Discount for Early Payment: diisi dengan jumlah persentase 

diskon yang diberikan pelanggan yang melakukan pembayaran 

piutang lebih awal 

e. % Monthly Charge for Late Payment: diisi dengan jumlah 

persentase denda yang diberikan perusahaan ketika pelanggan 

telat membayar piutang. 

Selanjutnya adalah klik OK. 

6. Isikan informasi yang berkaitan dengan transaksi penjualan kredit 

yang dilakukan. Adapun informasinya sebagai berikut: 

a. Invoice#: diisi dengan nomor faktur. 

b. Date: diisi dengan tanggal terjadinya transaksi. 

c. Customer PO#: diisi dengan nomor pesanan dari pelanggan. Jika 

tidak ada, abaikan saja kolom ini. 

d. Ship: diisi dengan jumlah jasa yang dijual kepada pelanggan. 

e. Backorder: diisi dengan jumlah barang yang dikembalikan. Jika 

tidak ada, biarkan kolom ini kosong. 

f. Item Number: diisi dengan kode jasa yang dijual. 

g. Description: akan terisi otomatis mengikuti kode jasa yang dipilih. 
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Gambar 7.10 Mengisi informasi penjualan kredit 

 

h. Price: diisi dengan harga jual jasa. 

i. Disc%: diisi dengan presentase potongan harga yang diberikan 

perusahaan pada pelanggan, jika ada. 

j. Total: akan terisi otomatis sejumlah harga dikalikan dengan 

jumlah jasa yang dijual. 

k. Tax: diisi dengan kebijakan pajak yang diberlakukan di 

perusahaan ketika terjadinya penjualan. Jika perusahaan 

mengambil PPN dari pelanggan, maka pada kolom tax diisi 

dengan PPN. Jika perusahaan tidak membebankan PPN kepada 

pelanggan, maka kolom tax diisi dengan N-T. 
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l. Freight: diisi jika ada biaya angkut yang ditanggung oleh pembeli. 

Kolom pajak diisi dengan N-T jika tanpa pajak atau diisi PPN jika 

dikenai pajak. 

m. Paid Today: diisi dengan sejumlah uang muka yang dibayarkan 

oleh pelanggan kepada perusahaan atau jika memang belum ada 

pembayaran sama sekali, maka biarkan kolom ini kosong. 

n. Klik Record. 

 

C. Pencatatan Pelunasan Piutang 

 

Dalam aplikasi MYOB ada fitur untuk melakukan pencatatan 

pelunasan piutang yang telah dibayarkan dari pelanggan, yaitu 

Receive Payments. Langkah-langkah untuk mencatat pelunasan 

piutang adalah sebagai berikut: 

1. Klik Sales ➔Receive Payments. 
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2. Pilih rekening (Deposit to Account) yang digunakan untuk 

menerima pembayaran dari pelanggan serta nama pelanggan 

yang membayar piutangnya. 

 
Gambar 7.11 Menentukan akun pelunasan piutang 

 

Isikan informasi terkait dengan pelunasan piutang dari 

pelanggan tersebut. Informasi yang perlu kita isi setelah memilih 

rekening nama customer, antara lain: 

a. ID#: diisi dengan nomor bukti pembayaran piutang oleh 

pelanggan. 

b. Date: diisi dengan tanggal transaksi pelunasan piutang. 

c. Amount Received: diisi dengan jumlah pembayaran yang 

diterima perusahaan. 
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d. Memo: diisi dengan catatan atau keterangan transaksi. 

e. Discount: akan terisi otomatis jika pembayaran belum 

melebihi periode diskon. 

f. Amount Applied: klik amount applied sejajar dengan jumla 

transaksi piutang yang dibayar. Jika di klik pada bagian ini 

maka nilai amount received akan otomatis terisi. Pastikan 

pada bagian Out of Balance bernilai 0. 

 
Gambar 7.12 Penerimaan pembayaran piutang 

 

3. Klik Record. 

Catatan: jika ingin melihat rekap transaksi (Recap Transaction) atau 

jurnalnya bagaimana, sebelum di-record bisa klik CTRL+R. 
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BAB VIII 

Transaksi Penerimaan 

dan Pengeluaran Kas 
 

 

Setelah mempelajari materi pada bab ini, siswa diharapkan: 

1. Mampu menjelaskan entry transaksi-transaksi penerimaan dan 

pengeluaran kas/bank bagi perusahaan jasa. 

2. Mampu mengentry pengentryan transaksi-transaksi penerimaan 

dan pengeluaran kas/bank bagi peusahaan jasa. 

3. Mampu mengecek kebenaran jurnal transaksi penerimaan dan 

pengeluaran kas. 

 

Aplikasi MYOB mempunyai fitur Banking yang digunakan untuk 

memasukkan transaksi penerimaan dan pengeluaran kas yang tidak 

berkaitan dengan pemasok maupun pelanggan. Pada menu banking ini 

terdapat beberapa fitur dengan fungsi masing-masing sebagai berikut: 

1. Spend Money: digunakan untuk mencatat transaksi 

pengeluaran/pembayaran kas perusahaan. 

2. Bank Register: digunakan untuk melihat tampilan ringkasan 

transaksi perbankan. 

3. Receive Money: digunakan untuk mencatat transaksi penerimaan 

kas di luar kegiatan operasional perusahaan. 

4. Prepare Electronic Payment: digunakan untuk menyimpan transaksi 

pengeluaran dengan  dana dari cek. 

5. Print Cheque: digunakan untuk mencetak cek dari perusahaan. 
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6. Reconcile Accounts: digunakan untuk pencatatan terkait rekonsiliasi 

bank. 

7. Prepare Bank Deposit: digunakan untuk mencatat transaksi yang 

penerimaan dana dari cek. 

8. Print/Email Remittance Advices: berfungsi untuk mencetak/ 

mengirim email nota pembayaran transaksi untuk pengeluaran cek. 

9. Transaction Jurnal: berfungsi untuk menampilkan semua jurnal 

yang telah dimasukkan. 

Transaksi pada perusahaan jasa pada umumnya hanya 

menggunakan dua fitur, yaitu Spend Money dan Receive Money. 

 
Gambar 8.1 Tampilan menu banking 

 

A. Transaksi Penerimaan Kas (Receive Money) 

Langkah –langkah untuk memasukkan transaksi penerimaan kas 

pada menu banking adalah sebagai berikut: 
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1. Klik menu Banking ➔ Receive Money 

 
Gambar 8.2 Menu receive money 

 

2. Pilih akun yang akan digunakan untuk penerimaan kas, dalam 

contoh soal di atas melalui bank mandiri. 
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Gambar 8.3 Tampilan memilih akun untuk penerimaaan 

 

3. Isikan semua informasi yang diperlukan untuk mencatat transaksi 

penerimaan kas sesuai tampilan di bawah ini. 

 
Gambar 8.4 Tampilan memasukkan transaksi penerimaan kas 
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a. Deposit to Account arahkan ke akun Bank Mandiri. 

b. Hilangkan centang pada kotak tax inclusive. 

c. ID # diisi dengan nomor bukti transaksi. 

d. Date diisi dengan tanggal terjadinya transaksi. 

e. Amount Receive isikan dengan nominal yang diterima. 

f. Memo diisi sesuai dengan keterangan transaksi. 

g. Acct # dipilih akun tandingan dari bank mandiri yang berada 

di sebelah kredit saja. Dalam contoh ini pilih nomor akun 3-

1000 (Modal Citra) karena transaksi ini berupa penyetoran 

modal.  

h. Name akan otomatis terisi setelah mengisi Acct#. 

i. Kolom Amount akan otomatis terisi setelah memasukan 

nominal pada Amount Receive. 

j. Kolom Tax diisi N-T, karena transaksi ini tidak disertai pajak. 

4. Setelah semua informasi di atas diisikan selanjutnya adalah 

mengecek kebenaran jurnal dengan cara klik CTRL+R dan akan 

muncul tampilan seperti pada Gambar 8.5. 

5. Apabila jurnal transaksi sudah selesai, klik OK pada tampilan 

recap transaction  in receive Money lalu klik Record. 
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Gambar 8.5 Tampilan jurnal transaksi penerimaan kas untuk setoran 

modal 

 

B. Transaksi Pengeluaran Kas (Spend Money) 

Langkah–langkah untuk memasukkan transaksi pengeluaran kas 

menggunakan Spend Money adalah sebagai berikut: 
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1. Klik menu Banking ➔Spend Money 

 
Gambar 8.6 Tampilan menu spend money 

 

2. Pilih akun yang akan digunakan untuk pembayaran kas dengan 

menekan tombol tanda menekan tombol tanda panah ke bawah 

di sebelah keterangan pay from account. 

 
Gambar 8.7 Tampilan memilih akun untuk pembayaran 
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3. Isikan semua informasi dari soal untuk mencatat transaksi 

pembayaran kas, sesuai dengan tampilan Gambar 8.8. 

a. Pay from Account : Arahkan untuk memilih sumber kas yang 

digunakan dalam transaksi. Pada contoh soal yang digunakan 

pilih akun kas kecil.  

b. Hilangkan tanda centang pada kolom Tax Inclusive. 

c. Cheque No diisi dengan nomor bukti transaksi. 

d. Date diisi dengan tanggal terjadinya transaksi. 

e. Amount diisi dengan nominal transaksi. 

f. Memo diisi dengan keterangan transaksi. 

g. Acct # diisikan dengan akun sebelah debit atau akun 

tandingan pengeluaran kas. Dalam conto soal yang digunakan 

arahkan akun pada Utang Gaji dan Upah karena contoh 

transaksi yang digunakan merupakan pembayaran utang gaji 

bulan November. 

h. Name dan Amount akan otomatis terisi setelah mengisi kolom 

Acct # dan Amount. 
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Gambar 8.8 Mencatat transaksi pengeluaran kas 

 

4. Langkah cek kebenaran jurnal adalah klik CTRL+R, sehingga akan 

muncul tampilan sebagai berikut. 

 
Gambar 8.9 Tampilan recap transaction jurnal pembayaran kas 

 

5. Setelah transaksi jurnal benar klik OK pada Recap Transaction in 

Spend Money lalu klik Record. 
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BAB IX 

Pencatatan Transaksi 

Jurnal Umum dan Penyesuaian 
 

 

Setelah mempelajari materi pada bab ini, siswa diharapkan: 

1. Mampu menjelaskan entry transaksi umum lainnya dan transaksi 

penyesuaian ke dalam buku jurnal umum perusahaan jasa. 

2. Mampu mengentry transaksi umum lainnya dan transaksi 

penyesuaian ke dalam buku jurnal umum perusahaan jasa. 

3. Mampu mengecek kebenaran jurnal umum. 

 

Selain mempunyai fitur untuk transaksi yang berkaitan dengan Banking, 

Purchase, dan Sales, myob juga menyediakan fitur khusus untuk 

transaksi yang tidak dapat dimasukkan kedalam tiga kategori di atas 

yaitu fitur Record Jurnal Entry. Fitur ini dapat dibuka pada menu 

Account – Record Journal Entry. 

 
Gambar 9.1 Tampilan record journal entry 
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Menu Record Journal Entry dapat digunakan untuk melakukan 

pencatatan penyusutan peralatan, pencatatan penyesuaian pada akhir 

periode akuntansi dan transaksi-transaksi yang tidak dapat masuk 

dalam klasifikasi Banking, Purchase, maupun Sales. Contohnya, transaksi 

pertukaran aktiva sejenis yang tidak melibatkan pembayaran kas. Pada 

menu ini kita perlu untuk menganalisis jurnal secara manualnya 

terlebih dahulu, karena untuk pencatatan harus dilakukan secara 

mandiri penentuan akunnya maupun posisi untuk debit kreditnya.  

 

A. Transaksi Penyusutan Peralatan 

 

Langkah - langkah memasukkan transaksi penyusutan aktiva tetap 

adalah sebagai berikut : 

1. Klik menu Account ➔Record Journal Entry. 

2. Isikan informasi terkait penyusutan peralatan yang akan dicatat 

seperti tampilan di bawah ini: 

a. General Journal # isikan dengan nomor bukti transaksi. 
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b. Date isi dengan tanggal penyusutan peralatan (penyusutan 

biasanya dilakukan akhir periode). 

c. Memo diisi dengan keterangan singkat tentang transaksi. 

d. Acct # isikan dengan kode akun yang digunakan untuk 

mencatat transaksi. 

e. Name akan otomatis terisi setelah mengisi kode akun. 

f. Debit diisi dengan jumlah nominal yang di akan debet. 

g. Credit diisi dengan jumlah nominal yang akan di kredit. 

 
Gambar 9.2 Tampilan pencatatan transaksi penyusutan peralatan 

 

3. Untuk mengecek kebenaran jurnal tekan CTRL+R. Jika transaksi 

sudah benar bisa di klik Record. 
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B. Transaksi Pemakaian Perlengkapan 

 

Langkah memasukkan transaksi pemakaian perlengkapan adalah 

sebagai berikut: 

1. Klik menu Inventory ➔Count Inventory 

 
Gambar 9.3 Tampilan menu count inventory 
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2. Pada Jendela Count Inventory ketik jumlah perlengkapan yang 

masih tersedia pada kolom Counted kemudian klik Adjust 

Inventory. 

 
Gambar 9.4 Mengisi perlengkapan yang tersisa 

 

3. Pada Tampilan jendela Adjust Inventory pilih akun Beban 

Perlengkapan pada Default Adjustment Account lalu klik continue. 
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Gambar 9.5 Memilih akun untuk penyesuaian perlengkapan 

 

4. Lengkapi Inventory Journal Number, date dan memo.  

 
Gambar 9.6 Jurnal pemakaian perlengkapan 



147 

 

5. Untuk mengecek kebenaran jurnal klik CTRL+R, seperti tampilan 

berikut: 

 
Gambar 9.10 Mengecek kebenaran jurnal 

 

6. Apabila jurnal sudah benar klik OK pada jendela Recap 

Transaction lalu klik Record. 

 

C. Transaksi Pencatatan Penyesuaian 

1. Penyesuaian pendapatan bunga dan biaya administrasi bank. 
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Langkah memasukkan transaksi: 

a. Klik menu Account ➔ Record Journal Entry 

b. Lengkapi jendela Record Journal Entry dengan informasi yang 

diperlukan untuk mengentry transaksi tersebut. 

 
Gambar 9.11 Tampilan entry jurnal AJP 3 
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c. Klik CTRL+R untuk mengecek kebenaran jurnal sesuai 

tampilan berikut ini: 

 
Gambar 9.12 Tampilan recap transaction 

 

Apabila transaksi sudah benar klik OK pada jendela recap 

transaction, lalu klik Record. 

 

2. Penyesuaian Beban Gaji 

 

Langkah memasukkan transaksi : 

a. Klik menu Account ➔Record Journal Entry 

b. Lengkapi jendela Record Journal Entry dengan informasi yang 

diperlukan untuk memasukkan transaksi tersebut. 
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Gambar 9.13 Tampilan entry jurnal AJP 4 

 

c. Langkah cek kebenaran jurnal adalah klik CTRL+R, sehingga 

muncul tampilan seperti berikut: 

 
Gambar 9.14 Tampilan recap transaction AJP4 
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d. Apabila transaksi telah benar, klik OK pada tampilan Recap 

Transaction, lalu Klik Record. 

 

3. Penyesuaian Beban Sewa dan Asuransi 

 

Langkah langkah memasukkan transaksi: 

a. Klik menu Account➔ Record Journal Entry 

b. Lengkapi jendela Record Journal Entry dengan informasi yang 

diperlukan untuk memasukkan transaksi tersebut (Gambar 

9.15). 

c. Langkah cek kebenaran jurnal adalah klik CTRL+R, sehingga 

muncul tampilan seperti pada Gambar 9.16. 

d. Apabila jurnal dicek sudah benar, klik OK pada tampilan 

Recap Transaction, lalu klik Record. 
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Gambar 9.15 Tampilan entry transaksi AJP 5 

 

 
Gambar 9.16 Tampilan Recap Transaction AJP 5 

 

e.  
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BAB X 

Mencetak Laporan Keuangan dan 

Backup File 
 

Setelah mempelajari materi pada bab ini, siswa diharapkan: 

1. Mampu menjelaskan pencetakan laporan keuangan untuk 

perusahaan jasa. 

2. Mampu menjelaskan pembuatan file backup untuk perusahaan jasa. 

3. Mampu mencetak laporan keuangan untuk perusahaan jasa. 

4. Mampu membuat file backup untuk perusahaan jasa. 

 

Pada saat seluruh rangkaian transaksi selesai dilakukan, selanjutnya 

adalah mencetak laporan keuangan. Laporan keuangan berguna untuk 

mengevaluasi kinerja sebuah perusahaan dan menggambarkan kondisi 

perusahaan. Ada beberapa laporan yang diperlukan oleh beberapa 

perusahaan di antaranya: laporan laba rugi, neraca, serta arus kas.  

A. Menampilkan dan Mencetak Laporan Laba Rugi  

Laporan laba rugi  adalah laporan yang keuangan yang menampilkan 

unsur pendapatan dan beban sehingga dapat diketahui laba / rugi 

bersih suatu perusahaan. Langkah untuk menampilkan laporan 

tersebut yaitu: 

1. Klik tombol dropdown pada menu Reports. 
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Gambar 10.1 Tampilan menu reports 

 

2. Klik Accounts ➔Profit and Loss (Accrual) ➔ Customize. 

Gambar 10.2 Tampilan menu accounts 
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3. Isi informasi mengenai tanggal periode laporan laba rugi yang 

akan ditampilkan pada bagian Advanced Filters ➔ Klik Display. 

 
Gambar 10.3 Pengisian informasi tanggal periode 

 

 
Gambar 10.4 Tampilan laporan laba rugi 
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4. Cara mengunduh laporan laba rugi dalam bentuk pdf, klik Send 

To dibagian bawah lalu pilih pdf. Sedangkan untuk mencetak 

laporan laba rugi klik Print.  

 

B. Menampilkan dan Mencetak Laporan Neraca 

Laporan Neraca (Posisi Keuangan) adalah laporan yang 

menampilkan komponen Aset, Kewajiban dan Modal. Cara 

menampilkan laporan neraca adalah sebagai berikut: 

1. Klik Reports ➔Accounts➔ Standard Balance Sheet ➔ 

Customize. 

2. Isi informasi mengenai tanggal periode laporan neraca yang akan 

ditampilkan pada bagian Advanced Filters ➔ Klik Display. 

 
Gambar 10.5 Pengisian informasi tanggal periode 
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3. Berikut tampilan untuk Laporan Neraca/Posisi Keuangan. 

Beberapa akun bisa di-klik untuk mengetahui detailnya transaksi 

yang berkaitan dengan akun tersebut selama periode akuntansi 

yang dikerjakan. 

 
Gambar 10.6 Tampilan laporan neraca 
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4. Cara mengunduh laporan neraca dalam bentuk pdf, klik Send To 

dibagian bawah lalu pilih pdf. Sedangkan untuk mencetak 

laporan neraca klik Print. 

 

C. Menampilkan dan Mencetak Laporan Arus Kas 

Laporan arus kas merupakan laporan yang menunjukkan aliran kas 

masuk dan keluar perusahaan dalam periode tertentu. Langkah-

langkah untuk menampilkan laporan arus kas sebagai berikut. 

1. Klik Reports ➔ Banking  

2. Klik Statement of Cash Flow ➔ Display 

 
Gambar 10.11 Tampilan menu banking 
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3. Berikut tampilan Laporan Arus Kas 

 
Gambar 10.12 Tampilan laporan arus kas 

 

4. Cara mengunduh laporan arus kas dalam bentuk pdf, klik Send 

To dibagian bawah lalu pilih pdf. Sedangkan untuk mencetak 

laporan arus kas klik Print.  
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D. Mencetak Jurnal Transaksi (Transaction Jurnal) 

Jika ingin mencetak jurnal transaksi selama 1 periode akuntansi, 

langkah yang harus dilakukan adalah sebagai berikut: 

1. Klik fitur Transaction Jurnal. 

2. Isikan tanggal dalam 1 periode yang akan dicetak. 

 
Gambar 10.13 Tampilan transaction journal 

 

Adapun beberapa opsi untuk mencetak jurnal transaksi: 

a. General, untuk mencetak jurnal umum 

b. Disbursement, untuk mencetak jurnal pengeluaran kas 
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c. Receipts, untuk mencetak jurnal penerimaan kas 

d. Sales, untuk mencetak jurnal penjualan 

e. Purchases, untuk mencetak jurnal pembelian 

f. Inventory, untuk mencetak jurnal terkait persediaan  

g. All, untuk mencetak keseluruhan jurnal satu periode 

3. Klik print untuk mencetak jurnal 

4. Jika telah selesai, klik close.  

 

E. Membuat File Backup Perusahaan Jasa 

Backup adalah membuat cadangan dari file-file yang penting. Tujuan 

pembuatan file backup dilakukan untuk menjamin keutuhan data 

ketika file aslinya mengalami kerusakan akibat virus dan sebagainya.  

Adapun langkah-langkah membuat file backup adalah sebagai 

berikut: 

1. Klik file ➔ Backup pada Toolbar menu 

 
Gambar 10.14 Menu backup 
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2. Tentukan pilihan Backup file, lalu klik continue 

 
Gambar 10.15 Pilihan backup file 

 

3. Klik OK apabila muncul notifikasi seperti pada gambar 10.16. 

 
Gambar 10.16 Notifikasi pengecekan file 

 

4. Tentukan lokasi penyimpanan dan nama file Backup. Sediakan 

lokasi penyimpanan yang berbeda dengan file asli. 
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Gambar 10.17 Lokasi penyimpanan file backup 

 

5. Klik save untuk menyimpan file Backup. 
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Soal Latihan 
 

A. Pembelian tunai, pembelian kredit, retur tunai, retur kredit, 

pembayaran utang 

Transaksi 1 

Tanggal 01 Desember 2017   No Bukti: KT-024 

Dibeli secara tunai kepada Toko Bersih dengan rincian sebagai 

berikut: 

Q Kode Keterangan Harga 

Satuan 

Jumlah 

10 Per-03 Pemutih “Bayclin Lemon 500 ml” 

10.000 100.000 

5 Per-04 Pelicin Pakaian “Rapika 450 ml”  10.000    50.000 

15 Per-06 Softener “ Soklin 900 ml” 25.000 375.000 

Jumlah 525.000 

PPN 52.500 

Total Termasuk PPN 577.500 

 

Transaksi 2 

Tanggal 04 Desember 2017  No Bukti: Fak.1 

Dibeli kepada Angkasa Elektonik peralatan dengan termin 2/10 

n/30. Dengan rincian sebagai berikut: 

Q Kode Keterangan Harga Satuan Jumlah 

2 Alat-03 Strika “Panasonic” 330.000    660.000 

2 Alat-05 Meja Strika” Tobi” 240.000    480.000 

Jumlah 1.140.000 

PPN     114.000 

Total Termasuk PPN 1.254.000 
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Transaksi 3 

Tanggal 10 Desember 2017   No Bukti: RT-01 

Dikirim kembali kepada toko bersih atas pembelian atas nota 

kontan KT-024 tertanggal 9 desember 2017  dengan rincian: 

Q Kode Keterangan Harga 

Satuan 

Jumlah 

03 Per-06 Softener “Soklin 900 ml” 25.000 75.000 

Jumlah 75.000 

PPN   7.500 

Total Termasuk PPN 82.500 

  

Transaksi 4 

Tanggal 11 Desember 2017  Nomor Bukti: RK-02 

Dikirim kembali kepada Toko Angkasa Elektronik atas barang 

dengan Nomor Faktur Fak.1 tanggal 04 Desember 2017 untuk 

rincian sebagai berikut: 

Unit Kode Keterangan Harga Satuan Jumlah 

1 Alat-03 Strika “Panasonic” 330.000 330.000 

Jumlah 330.000 

PPN 33.000 

Total termasuk PPN 363.000 

 

Transaksi 5 

Tanggal 19 Desember 2017   No Bukti: C12-1 

Dibayar kepada Toko Mesti Lengkap untuk pelunasan utang tanggal 

25/11/2017 No Faktur: FSM.33 . Dengan rincian: 

Utang  Rp2.251.000,- 

Potongan  - 

Jumlah  Rp2.251.000,- 
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B. Penjualan tunai, penjualan kredit, pelunasan piutang 

Transaksi 6 

  Tanggal 20 Desember 2017  No Bukti : BKM-01 

Diterima dari Klinik Sehat Usada Rp4.596.200,- untuk pelunasan 

piutang tanggal 25 November 2017 No.Faktur FJ-2511. Dengan 

rincian: 

Piutang Rp4.690.000,- 

Potongan Rp      93.800,- 

Jumlah Rp4.596.200,- 

 

Transaksi 7 

Tanggal 20 Desember 2017  No Bukti: F12-1 

Dijual kepada Panti Asuhan “ Al Ikhlas” termin 2/10 n/30. 

Dengan rincian sebagai berikut: 

Q Kode Keterangan Harga 

Satuan 

Jumlah 

23 LON-1 Laundry Komplit 10.000 230.000 

2 LON-2 Paket Hemat Komplit 220.000 440.000 

Jumlah 670.000 

PPN 67.000 

Total termasuk PPN 737.000 

 

Transaksi 8 

Tanggal 21 Desember 2017   No Bukti : NT12-1 

Dijual secara tunai kepada Customer Tunai dengan rincian 

sebagai berikut: 
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Q Kode Keterangan Harga 

Satuan 

Jumlah 

15 LON-1 Laundry Komplit 10.000 150.000 

13 LON-2 Laundry Kering    8.000 104.000 

1 LON-3 Paket Hemat Komplit 220.000 220.000 

1 LON-4 Paket Hemat Setrika 190.000 190.000 

Jumlah 664.000 

PPN     66.400 

Total Termasuk PPN 730.400 

 

C. Penerimaan kas dan pengeluaran kas 

Transaksi 9 

Tanggal 22 Desember 2017   Nomor Bukti: BKM-3 

Ibu Citra (pemilik) menyetorkan dana sebesar Rp3.000.000,- ke 

kas perusahaan. 

 

Transaksi 10 

Tanggal 23 Desember 2017   No.Bukti  :VKK-1 

Dibayarkan kepada Karyawan Laundry Rp680.000,- untuk 

pembayaran kekurangan gaji karyawan bulan November. 

 

D. Transaksi terkait rekonsiliasi, jurnal umum, dan 

penyesuaian 

Transaksi 11 

Tanggal 31 Desember 2017  Nomor Bukti : BM12-1 

Jurnal penyesuaian: penyusutan peralatan Desember 2017 

sebesar Rp618.000,- 
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Transaksi 12 

Tanggal 31 Desember 2017  Nomor Bukti: BM12-2 

Data persediaan perlengkapan yang masih tersedia: 

Kode Nama Item Kuantitas 

Per-01 Detergen “Rinso Molto 900gr” 28 

Per-02 Detergen “ Daia Putih 900 gr” 17 

Per-03 Pemutih “ Bayclin Lemon 500 ml” 21 

Per-04 Pelicin Pakaian” Rapika 450 ml” 20 

Per-05 Pewangi “Molto 450 ml” 19 

Per-06 Softener “ SoKlin 900 ml” 20 

Per-07 Plastik merah besar 225 

Per-08 Plastik hitam sedang 95 

Per-09 Kertas Nota 3 

Per-10 Isolasi 4 

Per-11 Steples 2 

 

Transaksi 13 

Tanggal 31 Desember 2017  Nomor Bukti : BM12-3 

Citra meminta kepada bagian pembukuan untuk melakukan 

rekonsiliasi bank. Berdasarkan laporan dari pihak Bank Mandiri 

diperoleh informasi sebagai berikut: 

Pendapatan Jasa Giro Rp1.080.000,- 

Biaya Administrasi Bank Rp   240.000, 

 

Transaksi 14 

Tanggal 31 Desember 2017  Nomor Bukti : BM12-4 

Jurnal penyesuaian: Gaji bulan Desember sebesar Rp2.480.000,- 

akan dibayarkan tanggal 2 Januari 2018. 
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Transaksi 15 

Tanggal 31 Desember 2017  Nomor Bukti: BM12-5 

Data penyesuaian akhir periode: 

Beban sewa Bulan Januari  Rp640.000,- 

Asuransi yang kedaluarsa  Rp466.000,- 
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